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Αληί πξνιόγνπ 
 

Η δεκηνπξγία κηαο ηζηνζειίδαο είλαη εύθνιε. Η δεκηνπξγία κηαο επηηπρεκέλεο 

ηζηνζειίδαο είλαη κηα δηαδξαζηηθή δηαζύλδεζε, κηα πξόθιεζε γηα ην θνηλό θαη ην 

αθξναηήξην ζην νπνίν απεπζύλεηαη.  

Σν Internet κε ηηο ηξέρνπζεο θαη αλαδπόκελεο δπλαηόηεηεο ησλ πνιπκέζσλ 

πνπ παξέρεη, πξνζθέξεη άθζνλεο επθαηξίεο θαη είλαη ηδηαίηεξα ρξήζηκν. Οη ζύγρξνλεο 

εηαηξείεο γηα λα απνθηήζνπλ έλα αληαγσληζηηθό πιενλέθηεκα ζηελ αγνξά, 

εθκεηαιιεύνληαη ζην έπαθξν ην πιεξνθνξηαθό θαη ζπλαιιαθηηθό δπλακηθό ηνπ 

Γηαδηθηύνπ.  

Η παξνύζα εξγαζία πεξηγξάθεη όια ηα ζηάδηα θαηαζθεπήο κηαο ηζηνζειίδαο, 

ηα ραξαθηεξηζηηθά ηεο, ηνλ ζρεδηαζκό ηεο, ηε δηαδξαζηηθόηεηα, ηελ πινήγεζε, ηε 

ιεηηνπξγηθόηεηα, κε ζθνπό ηελ αμηνπνίεζε ηνπ πιήξεο δπλακηθνύ ηνπ Γηαδηθηύνπ.  

Γηα ηελ θαηαζθεπή ηεο ηζηνζειίδαο ρξεζηκνπνηήζεθε έλα ζύγρξνλν, 

δεκνθηιέο ζύζηεκα δηαρείξηζεο πεξηερνκέλνπ ην Joomla, ην νπνίν πξνζθέξεηαη 

ζήκεξα δσξεάλ.  

΢ηελ πνξεία εθπόλεζεο απηήο ηεο εξγαζίαο, ππήξμαλ πνιιά πξόζσπα, πνπ ε 

ζπκβνιή θαη ε βνήζεηά ηνπο, ππήξμε θαζνξηζηηθή. Θα ήζεια εηιηθξηλά λα 

επραξηζηήζσ, ηνλ επηβιέπνληα θαζεγεηή κνπ θ. Κώζηα Κνπθνπιέηζν, γηα ηελ 

ελζάξξπλζε, ηελ ππνζηήξημε θαη ηελ  εκπλεπζκέλε θαζνδήγεζή ηνπ. Οη θαίξηεο 

παξαηεξήζεηο ηνπ, νη νδεγίεο θαη νη παξνηξύλζεηο ηνπ, κε δηεπθόιπλαλ λα 

πξνζεγγίζσ ην ζέκα κε κηα δηαθνξεηηθή νπηηθή θαη ηνλ επραξηζηώ ζεξκά γη‟ απηό. Σν 

ηδηαίηεξν ελδηαθέξνλ ηνπ, ε δηάζεζή ηνπ γηα επηθνηλσλία θαη ε επηζηεκνληθή ηνπ 

γλώζε, απνηέιεζε πεγή έκπλεπζεο γηα όινπο ηνπο θνηηεηέο θαη γηα κέλα πξνζσπηθά. 

Πνιύηηκε ήηαλ ε βνήζεηα ηεο αδεξθή κνπ Δηξήλεο, πηπρηνύρν Μαζεκαηηθό 

ηνπ Παλεπηζηεκίνπ Αζελώλ, ε νπνία κε κεγάιε πξνζπκία θαη θαηαλόεζε, κέζα από 

δηεμνδηθέο ζπδεηήζεηο, ζπλέβαιε θαη ππνζηήξημε κε ηνλ δηθό ηεο ηξόπν, ηελ όιε κνπ 
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πξνζπάζεηα. Η ζπλερήο πξνηξνπή θαη ελζάξξπλζή ηεο, ζε πεξηόδνπο κεγάιεο 

θόπσζεο θαη κείσζεο ησλ δπλάκεώλ κνπ ήηαλ πνιύ ζεκαληηθή γηα κέλα.  

Σέινο ζα ήζεια λα επραξηζηήζσ ηδηαίηεξα ηνπο γνλείο κνπ, γηα ηελ πνιύηηκε 

βνήζεηά ηνπο θαη θπξίσο γηα ηελ εκπηζηνζύλε πνπ κνπ έδεημαλ.  Η ζπκβνιή ηνπο 

ήηαλ θαζνξηζηηθήο ζεκαζίαο ζηελ πνξεία θαη εμέιημε ηεο παξνύζαο εξγαζίαο. 

 

 

 
Μπαιηνύζθαο ΢ηαύξνο  

Πεηξαηάο 2016 
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Δηζαγωγή 

΢θνπόο ηεο παξνύζαο πηπρηαθήο εξγαζίαο είλαη ε δεκηνπξγία ηζηνζειίδαο 

μελνδνρεηαθήο κνλάδαο. Η θαηαζθεπή ηεο έγηλε ρξεζηκνπνηώληαο έλα από ηα πην 

δεκνθηιή CMS (Content Management System) ζηνλ θόζκν ην Joomla. Πξνθαλώο 

ππάξρνπλ θαη άιια CMS, (όπσο π.ρ ην WordPress, Drupal θ.α.), αιιά επηιέμακε ην 

Joomla γηαηί αθελόο είλαη κία δσξεάλ εθαξκνγή, αλνηρηνύ θώδηθα ζύζηεκα 

δηαρείξηζεο πεξηερνκέλνπ, ην νπνίν ρξεζηκνπνηεί ζαλ γιώζζα πξνγξακκαηηζκνύ ηελ 

PHP γηα ηε δηαρείξηζε θαη ηε δεκνζίεπζε πεξηερνκέλνπ ζηνλ ηζηό (web), ζπλδέεηαη 

εύθνια κε κηα βάζε δεδνκέλσλ ηελ MySQL θαη αθεηέξνπ ππάξρεη πιεζώξα 

δηαζέζηκσλ Templates δσξεάλ αιιά θαη εκπνξηθά, θαζώο θαη έηνηκα Μodules, 

Plugins θαη Components δσξεάλ θαη εκπνξηθά ηα νπνία δηεπθνιύλνπλ ζηελ 

δηακόξθσζε επηζπκεηήο ηζηνζειίδαο. Δπίζεο είλαη θηιηθό πξνο ην ρξήζηε θαη εύθνια 

κεηαηξέπεηαη ε ηζηνζειίδα ζε πνιπγισζζηθή. 

Μπνξνύκε λα ην θαηεβάζνπκε από ηελ ηζηνζειίδα ηνπ Joomla (1), όπσο θαη από 

ηελ ηζηνζειίδα Joomla (2). 
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ΚΔΦΑΛΑΙΟ 1 

1.1.       WAMP Server 
 

Ξεθηλήζακε ηελ εξγαζία καο εγθαζηζηώληαο ζηνλ ππνινγηζηή καο ηνλ WAMP 

Server. Ο WAMP Server είλαη ινγηζκηθό αλνηρηνύ θώδηθα πνπ καο δίλεη ηελ 

δπλαηόηεηα λα θάλνπκε ηνλ ππνινγηζηή καο Web Server. Αλαθέξεηαη ζε έλα ζύλνιν 

πξνγξακκάησλ γηα ην ιεηηνπξγηθό ζύζηεκα Microsoft Windows, πνπ δεκηνπξγήζεθε 

από ηνλ Romain Bourdon θαη απνηειείηαη από ηνλ Web Server Apache, ηε βάζε 

δεδνκέλσλ MySQL θαη ηελ γιώζζα πξνγξακκαηηζκνύ PHP. Σν όλνκα WAMP 

απνηειείηαη από ηα αξρηθά: 

• W:  Windows.  Απηό ζεκαίλεη όηη ν Server απηόο ιεηηνπξγεί κόλν ζε ιεηηνπξγηθό 

΢ύζηεκα windows. 

• A:  Apache.  Γειαδή ν Web Server είλαη ν Apache. 

• M:  MySQL. Υξεζηκνπνηεί ηελ βάζε δεδνκέλσλ MySQL . 

•  P: PHP. Δίλαη κία γιώζζα πξνγξακκαηηζκνύ γηα ηε δεκηνπξγία δπλακηθώλ 

ηζηνζειίδσλ.    

1.2.       Apache HTTP εμππεξεηεηήο 
 

Ο Apache HTTP είλαη έλαο εμππεξεηεηήο ηνπ παγθόζκηνπ ηζηνύ (web). Όηαλ 

έλαο ρξήζηεο επηζθέπηεηαη κία ηζηνζειίδα, ν Web Browser επηθνηλσλεί κε έλαλ 

δηαθνκηζηή (Server) κέζσ ηνπ πξσηνθόιινπ HTTP, ν νπνίνο παξάγεη ηηο ηζηνζειίδεο 

θαη ηηο ζηέιλεη ζην ρξήζηε κε απνηέιεζκα λα ηηο δεη ζηελ νζόλε ηνπ. O Apache είλαη 

έλαο από ηνπο δεκνθηιέζηεξνπο εμππεξεηεηέο ηζηνύ, γηαηί ιεηηνπξγεί ζε δηάθνξα 

ιεηηνπξγηθά ζπζηήκαηα όπσο ην Windows, ην Linux, ην Unix θαη ην MacOSx. 

Κπθινθόξεζε ππό ηελ άδεηα ινγηζκηθνύ Apache θαη είλαη πξόγξακκα αλνηρηνύ 

θώδηθα. ΢πληεξείηαη από κηα θνηλόηεηα αλνηθηνύ θώδηθα κε επηηήξεζε από ην 

Ίδξπκα Λνγηζκηθνύ Apache (Apache Software Foundation). 

Ο Apache ρξεζηκνπνηείηαη θαη ζε ηνπηθά δίθηπα ζαλ Web Server 

ζπλεξγαδόκελνο κε ζπζηήκαηα δηαρείξηζεο Βάζεο Γεδνκέλσλ π.ρ. Oracle, MySQL. 
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1.3.       MySQL 
 

Η MYSQL είλαη έλα ζύζηεκα δηαρείξηζεο βάζεσλ δεδνκέλσλ πνπ κεηξά 

πεξηζζόηεξεο από 11 εθαηνκκύξηα εγθαηαζηάζεηο. Έιαβε ην όλνκά ηεο από ηελ θόξε 

ηνπ Μόληπ Βηληέληνπο, ηε Μάη (My). Σν πξόγξακκα ηξέρεη έλαλ εμππεξεηεηή 

(Server) παξέρνληαο πξόζβαζε πνιιώλ ρξεζηώλ ζε έλα ζύλνιν βάζεσλ δεδνκέλσλ. 

Η MySQL είλαη κία δεκνθηιήο βάζε δεδνκέλσλ γηα δηαδηθηπαθέο εθαξκνγέο θαη 

ηζηνζειίδεο. Υξεζηκνπνηείηαη από ηηο πην δηαδεδνκέλεο δηαδηθηπαθέο ππεξεζίεο, όπσο 

ην Youtube, Wikipedia, Google, Facebook θαη Twitter. 

1.4.       PHP 
 

PHP (Hypertext Preprocessor) είλαη κηα γιώζζα πξνγξακκαηηζκνύ γηα ηε 

δεκηνπξγία δπλακηθώλ ηζηνζειίδσλ. Μηα ζειίδα PHP πεξλά από επεμεξγαζία από 

έλα ζπκβαηό web Server (ζπλήζσο ν Apache), ώζηε λα παξαρζεί ζε ιίγα 

δεπηεξόιεπηα ην ηειηθό πεξηερόκελν ηεο ζειίδαο, πνπ είηε ζα ζηαιεί ζην πξόγξακκα 

θπιινκεηξεηή ηζηνύ ησλ επηζθεπηώλ ζε κνξθή θώδηθα HTML ή ζα επεμεξγαζηεί ηηο 

εηζόδνπο δίρσο λα πξνβάιιεη ηελ έμνδν ζην ρξήζηε, αιιά ζα ηηο κεηαβηβάζεη ζε 

θάπνην άιιν PHP script. Η PHP απνηειεί κηα από ηηο πην δηαδεδνκέλεο ηερλνινγίεο 

ζην Παγθόζκην Ιζηό, θαζώο ρξεζηκνπνηείηαη από πνιιέο εθαξκνγέο θαη ηζηνζειίδεο. 

Υξεζηκνπνηείηε ηαθηηθά θαη είλαη εύθνιε ζηελ ρξήζε πξνγξακκαηηζκνύ αιιά θαη 

ζην γεγνλόο πσο είλαη κηα γιώζζα ε νπνία βξίζθεηαη ζρεδόλ ζε θάζε εμππεξεηεηή. 

Γηάζεκεο εθαξκνγέο πνπ έρνπλ γξαθηεί ζε γιώζζα PHP είλαη ην γλσζηό ΢ύζηεκα 

Γηαρείξηζεο Πεξηερνκέλνπ (Content Management System) Word Press, ην Drupal 

θαη ην Joomla. 
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ΚΔΦΑΛΑΙΟ 2 

2.1.   Δγθαηάζηαζε  πξνγξακκάηωλ 

Σν πξώην θαη βαζηθόηεξν πξόγξακκα πνπ κεηαθέξακε ζηνλ ππνινγηζηή καο 

γηα λα κπνξέζνπκε λα εγθαηαζηήζνπκε ην Joomla, είλαη ν WAMP. 

Γξάθνληαο ζην Web Browser Google Chrome ή ζηo Internet Explorer ή ζε 

όπνην άιιν πξόγξακκα πεξηήγεζεο ηελ θξάζε Wamp, καο εκθαλίδεηαη ε εηθόλα 1:  

 

 
Εικόνα 1  WampServer 

΢ην πξώην link επηιέγνπκε Download Wampserver 64bits, γηαηί ε 

αξρηηεθηνληθή ηνπ ππνινγηζηή καο είλαη 64 bits. Αλ έρεηε ππνινγηζηή αξρηηεθηνληθήο 

32 bits, επηιέμεηε  Download Wampserver 32bits. ΢ηελ ζπλέρεηα εκθαλίδεηαη ε 

εηθόλα πνπ βιέπνπκε παξαθάησ. Αθνινπζνύκε ηηο νδεγίεο εγθαηάζηαζεο κέρξη ην 

πξόγξακκα λα εγθαηαζηαζεί πιήξσο ζηνλ ππνινγηζηή καο. Η όιε εγθαηάζηαζε 

δηαξθεί κόιηο ιίγα ιεπηά. 

Η επηηπρήο εγθαηάζηαζε ηνπ Wamp θαίλεηαη από ην ρξώκα πνπ ζα πάξεη ην 

θνπηάθη θάησ δεμηά. Δάλ ην θνπηάθη θαηαιήμεη ζε ρξώκα πξάζηλν, ζεκαίλεη όηη όιεο 

νη ππεξεζίεο ηνπ Wamp ιεηηνπξγνύλ ζσζηά. Δάλ θαηαιήμεη ζε πνξηνθαιί ζεκαίλεη 

όηη κία ηνπιάρηζηνλ ππεξεζία ηνπ δελ ιεηηνπξγεί ζσζηά. Δάλ θαηαιήμεη ζε θόθθηλν 

ζεκαίλεη όηη θακία ππεξεζία ηνπ Wamp δελ ιεηηνπξγεί. 
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΢ηελ εηθόλα 2 βιέπνπκε όηη ην θνπηάθη θαηέιεμε ζε πξάζηλν, ζπλεπώο όιεο νη 

ππεξεζίεο ηνπ Wamp ιεηηνπξγνύλ ζσζηά θαη κπνξνύκε λα ηνλ ρξεζηκνπνηήζνπκε. 

 

Εικόνα 2  WampServer 

 

2.1.1.   Γεκηνπξγία βάζεο δεδνκέλωλ πξηλ ηελ εγθαηάζηαζε ηνπ Joomla. 
 

Πξηλ πξνρσξήζνπκε ζηελ εγθαηάζηαζε ηνπ Joomla δεκηνπξγήζακε κία βάζε 

δεδνκέλσλ γηα λα κπνξέζεη λα ζπλδεζεί κε εθείλε θαηά ηελ δηάξθεηα ηεο 

εγθαηάζηαζή ηνπ.  

Αξρηθά αλνίμακε έλα πξόγξακκα πεξηήγεζεο, όπνην επηζπκνύκε (επηιέμνπκε ην 

Google Chrome) , πιεθηξνινγνύκε ηελ δηεύζπλζε : localhost/phpmyadmin θαη 

εκθαλίδεηαη ε εηθόλα 3: 
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Εικόνα 3  Phpmyadmin 

΢ε πεξίπησζε πνπ δεηείηαη Username θαη Password (όπσο ζπλέβε ζε εκέλα) 

αλαδήηεζα ιύζε ζην πξόβιεκα θαη θαηέιεμα όηη ηα default Username θαη Password 

είλαη Username : root θαη Password : ” “. Η είζνδνο έδσζε ηελ εηθόλα 4: 

 

Εικόνα 4  Δημιουργία βάςησ δεδομζνων hotel1 

΢ηελ παξαπάλσ εηθόλα γηα ηελ δεκηνπξγία βάζεο επηιέμακε Databases. 

Αθνινύζσο γηα ηελ δεκηνπξγία ηεο θαηλνύξγηαο βάζεο γξάςακε όλνκα (ζηελ 

πεξίπησζή καο hotel1) θαη ζηελ επηινγή Collation επηιέμακε utf8_general_ci. Η 

δεκηνπξγία ηεο βάζεο hotel1 νινθιεξώζεθε κε ηελ επηινγή Create. Η δηαπίζησζε 

ηεο δεκηνπξγίαο θαίλεηαη από ην κήλπκα επηηπρνύο δεκηνπξγίαο ηεο βάζεο, αιιά θαη 

από ηελ εκθάληζε ηνπ νλόκαηόο ηεο αξηζηεξά ζηνλ πίλαθα ησλ βάζεσλ όπσο 

θαίλεηαη ζηελ εηθόλα 5. 
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Εικόνα 5  Επιτυχήσ δημιουργία τησ βάςησ hotel1 

2.2.   Δγθαηάζηαζε ηνπ Joomla 
 

Ξεθηλήζακε κε ηελ δεκηνπξγία ελόο θαθέινπ επηιέγνληαο έλα όλνκα hotel1 

ζηελ δηεύζπλζε C:/wamp/www ώζηε λα εγθαηαζηήζνπκε ζε απηό ην θάθειν ην 

Joomla. Γηα ηελ  εγθαηάζηαζε ηνπ Joomla αλαθέξακε ηηο δηεπζύλζεηο απ‟ ηηο νπνίεο 

κπνξνύκε λα θαηεβάζνπκε ην πξόγξακκα. Δκείο επηιέμακε ηελ δηεύζπλζε ηεο 

ηζηνζειίδαο ηνπ Joomla (1). Σελ πιεθηξνινγήζακε ζε έλαλ θπιινκεηξεηή  θαη 

εκθαλίδεηαη ε εηθόλα 6. Από απηήλ επηιέμακε Download. 

 

Εικόνα 6  Ιςτοςελίδα του Joomla 
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    Δκθαλίδεηαη ε Δηθόλα 7. 

  

Εικόνα 7  Κατζβαςμα τησ ζκδοςησ Joomla 3.6.4 

Δπηιέγνπκε ηελ ηειεπηαία έθδνζε ηνπ Joomla 3.6.4 θαη παηάκε Download γηα λα 

θαηέβεη ην πξόγξακκα ζε κνξθή .zip, γεγνλόο ην νπνίν απαηηεί κεξηθά ιεπηά ηεο 

ώξαο. Σν αξρείν .zip από ηηο ιήςεηο ην κεηαθέξνπκε ζην θάθειν hotel1, θάλνπκε 

Extract εθεί κέζα θαη πιεθηξνινγνύκε ην URL localhost/hotel1/administrator 

πξνθεηκέλνπ λα εγθαηαζηήζνπκε ην Joomla θαη λα ην ζπλδέζνπκε κε ηε βάζε. 

Δκθαλίδεηαη παξάζπξν βαζηθώλ ξπζκίζεσλ ζην νπνίν ζπκπιεξώλνπκε ηα πεδία 

πνπ βξίζθνληαη ζηηο Βαζηθέο Ρπζκίζεηο (όρη όια, εθείλα πνπ είλαη απαξαίηεηα). ΢ην 

πεδίν Όλνκα  Ιζηνζειίδαο * ζπκπιεξώλνπκε ην όλνκα ηεο ηζηνζειίδαο καο ην νπνίν 

πξνθαλώο ζα βιέπνπλ νη επηζθέπηεο (ζηελ πεξίπησζή καο Ξελνδνρείν ΢ηαπξάθεο). 

΢ην πεδίν Ηιεθηξνληθό ηαρπδξνκείν Γηαρεηξηζηή * πιεθηξνινγνύκε ην e-mail ηνπ 

Γηαρεηξηζηή (δειαδή ην e-mail καο). ΢ην πεδίν Όλνκα ρξήζηε Γηαρεηξηζηή * 

πιεθηξνινγνύκε έλα όλνκα ρξήζηε γηα ηνλ Γηαρεηξηζηή. ΢ην πεδίν Κσδηθόο 

Γηαρεηξηζηή * βάδνπκε έλαλ θσδηθό γηα ηνλ Γηαρεηξηζηή, θαη ζην πεδίν Δπηβεβαίσζε 

Κσδηθνύ Γηαρεηξηζηή * επαλαιακβάλνπκε ηνλ ίδην θσδηθό πνπ πιεθηξνινγήζακε 

ζην πεδίν Κσδηθόο Γηαρεηξηζηή, γηα επηβεβαίσζε όηη πιεθηξνινγήζακε ηνλ ζσζηό 

θσδηθό. Οη θσδηθνί είλαη απαξαίηεηνη γηα ζύλδεζε ηνπ Γηαρεηξηζηή κε ην πεξηβάιινλ 

δηαρείξηζεο ηνπ Joomla. Σν παξάζπξν ζπκπιεξσκέλν θαίλεηαη ζηελ εηθόλα 8. 
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Εικόνα 8  Βαςικζσ Ρυθμίςεισ 

΢ηα ππόινηπα πεδία δελ ρξεηάζηεθε λα ζπκπιεξώζνπκε ηίπνηα θαη παηάκε 

επόκελν. 

΢ην παξάζπξν πνπ εκθαλίδεηαη πξέπεη λα γίλεη ε ζύλδεζε ηνπ Joomla κε ηελ 

βάζε δεδνκέλσλ.  

΢ηα αληίζηνηρα πεδία ζπκπιεξώλνπκε: 

• Δίδνο βάζεο δεδνκέλσλ *  επηιέγνπκε ηελ MySQLi. 

• Όλνκα δηαθνκηζηή * πιεθηξνινγνύκε localhost. 

• Όλνκα ρξήζηε * πιεθηξνινγνύκε root. 

• Όλνκα ηεο Βάζεο Γεδνκέλσλ * πιεθηξνινγνύκε hotel1. 

Σν Πξόζεκα πίλαθα * είλαη ζπκπιεξσκέλν (by default) θαη δελ ρξεηάδεηαη αιιαγή. 

Σν παξάζπξν ζπκπιεξσκέλν θαίλεηαη ζηελ εηθόλα 9. 
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Εικόνα 9  Βαςικζσ ρυθμίςεισ βάςησ δεδομζνων και ςφνδεςη τησ με το Joomla 

΢ηα ππόινηπα πεδία δελ ρξεηάζηεθε λα ζπκπιεξώζνπκε ηίπνηα, απιά επηιέγνπκε 

επόκελν. 

 

Εικόνα 10  Επιλογή του check box Προεπιλεγμζνο ενδεικτικό περιεχόμενο ςτα αγγλικά (GB) 

΢ηελ εηθόλα 10 πνπ εκθαλίζηεθε από ην check box επηιέγνπκε γηα ηελ 

Δγθαηάζηαζε ελδεηθηηθνύ πεξηερνκέλνπ ην ήδε Πξνεπηιεγκέλν Δλδεηθηηθό 

πεξηερόκελν ζηα αγγιηθά (GB) θαη επηιέγνπκε Δγθαηάζηαζε. Μεηά από ιίγα ιεπηά 

παξαηεξνύκε όηη ε εγθαηάζηαζε ηνπ Joomla πξαγκαηνπνηήζεθε επηηπρώο 

επηβεβαηώλνληαο κε κήλπκα όπσο θαίλεηαη ζηελ εηθόλα 11 πνπ εκθαλίδεηαη. 
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Εικόνα 11  Αφαίρεςη του φακζλου INSTALLATION 

 

Σειεπηαία θίλεζε όπσο άιισζηε καο πξνηξέπεη, είλαη λα δηαγξάςνπκε ην θάθειν 

INSTALLATION παηώληαο ην ζρεηηθό πιήθηξν. 

Με ηελ επηηπρή εγθαηάζηαζε ηνπ Joomla είκαζηε ζε ζέζε λα απνθηήζνπκε 

πξόζβαζε ζην δηαρεηξηζηηθό ηνπ, κέζσ ηνπ θνπκπηνύ Γηαρεηξηζηήο αιιά θαη λα 

απνθηήζνπκε πξόζβαζε ζηελ θεληξηθή ζειίδα ηνπ κέζσ ηνπ θνπκπηνύ Ιζηνζειίδα. 

Γηα λα απνθηήζνπκε πξόζβαζε ζην δηαρεηξηζηηθό ηνπ Joomla, επηιέγνπκε 

Γηαρεηξηζηήο. Δκθαλίδεηαη ε θόξκα κε ηα πεδία ησλ Username θαη Password. Σα 

πιεθηξνινγνύκε θαη παηάκε Log in. 

Το παράθυρο που εκθαλίδεηαη πεξηέρεη ην Control Panel όπσο δείρλεη ε εηθόλα 12. 
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Εικόνα 12  Διαχειριςτικό του Joomla  (Σμήμα Backend) 

Σν δηαρεηξηζηηθό ηνπ Joomla πνπ εκθαλίζηεθε παξέρεη όια ηα απαξαίηεηα 

εξγαιεία θαη όιεο ηηο απαξαίηεηεο δπλαηόηεηεο κέζσ ησλ νπνίσλ ν Γηαρεηξηζηήο 

κπνξεί λα δεκηνπξγήζεη κία ηζηνζειίδα θαη λα ηελ ηξνπνπνηήζεη όηαλ ρξεηαζηεί. 

Μπνξεί λα δεκηνπξγήζεη, λα επεμεξγαζηεί, λα δηαγξάςεη, λα απνθξύςεη, αιιά θαη λα 

εκθαλίζεη άξζξα, κελνύ, ζηνηρεία κελνύ, Modules. Μπνξεί λα εγθαηαζηήζεη λέα 

Templates θαη λα επεμεξγαζηεί ηα ίδηα ηα Templates. Μπνξεί λα αλεβάζεη εηθόλεο, λα 

επεμεξγαζηεί ηηο ξπζκίζεηο ηνπ Joomla, λα εγθαζηζηά λέα Modules, Components θαη 

Plugins, λα εγθαζηζηά ην Component Αkeeba Backup γηα λα θξαηάεη ν Γηαρεηξηζηήο 

αληίγξαθν αζθάιεηαο νιόθιεξεο ηηο ηζηνζειίδαο θαη όηη άιιν είλαη απαξαίηεην γηα 

ηελ θαιύηεξε εκθάληζε κηαο δπλακηθήο ηζηνζειίδαο. 

Γηα λα δνύκε ηώξα ηελ θεληξηθή ζειίδα ηνπ Joomla παηάκε πάλσ δεμηά ζην 

Ξελνδνρείν ΢ηα… (δειαδή Ξελνδνρείν ΢ηαπξάθεο απιά εθεί δελ ρσξάεη όιν ην 

όλνκα). Κάλνληαο θιηθ βιέπνπκε ηελ θεληξηθή ζειίδα όπσο δείρλεη ε εηθόλα 13. 



Σταύροσ Μπαλιούςκασ Σελίδα 19 
 

 

Εικόνα 13  Κεντρική ςελίδα του Joomla (Σμήμα Frontent) 
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ΚΔΦΑΛΑΙΟ 3 

3.1.   Η δνκή ηνπ Joomla 

΢ην Joomla εκθαλίδνληαη δύν ηκήκαηα: 

• Σν ηκήκα Frontend (Γεκόζην ηκήκα, ή κπξνζηηλό ηκήκα). 

Σν ηκήκα Frontend είλαη απηό πνπ βιέπνπλ νη ρξήζηεο κόιηο επηζθεθηνύλ ηελ 

ηζηνζειίδα  (δειαδή είλαη ε θεληξηθή ζειίδα ε νπνία εκθαλίδεηαη ζηνπο ρξήζηεο)  

Joomla  (3). 

• Σν ηκήκα Backend  ( Πεξηνρή δηαρείξηζεο - πίζω ηκήκα). 

Δίλαη ην πεξηβάιινλ εξγαζίαο γηα ηνπο Γηαρεηξηζηέο ηζηνζειίδαο νη νπνίνη 

επεμεξγάδνληαη θαη εκθαλίδνπλ ηα πεξηερόκελα ησλ ηζηνζειίδσλ ρξεζηκνπνηώληαο ηα 

δηάθνξα εξγαιεία αιιά θαη ηηο δπλαηόηεηεο πνπ πεξηέρεη ην Joomla. 

 

3.2.   Σα Μελνύ 

Σα κελνύ είλαη αληηθείκελα πινήγεζεο πνπ θαζνξίδνπλ ην πώο ζα εκθαληζηεί 

ην πεξηερόκελν ηεο ζειίδαο. Έλα κελνύ κπνξεί λα πεξηέρεη έλα ε πεξηζζόηεξα 

ζηνηρεία Μελνύ, έηζη ώζηε θάλνληαο click πάλσ ζε απηά λα εκθαλίδεηαη ην 

πεξηερόκελν ηεο ζειίδαο.   

 

3.3.   Δπεθηάζεηο 

Δίλαη έλα κελνύ ζηελ γξακκή κελνύ ηνπ ηκήκαηνο Backend ηνπ Joomla θαη 

ρξεζηκνπνηείηαη γηα λα κπνξεί ν Γηαρεηξηζηήο λα εγθαζηζηά δηάθνξα αξρεία .zip από 

ηνλ ππνινγηζηή ηνπ ζην πεξηβάιινλ ηνπ Joomla. 

3.3.1.   Δίδε επεθηάζεωλ 

Τπάξρνπλ πέληε Δίδε επεθηάζεσλ: 

• Πξόηππα (Templates) 

• Δθαξκνγέο (Components) 

• Δλζέκαηα (Modules) 

• Πξόζζεηα (Plugins) 

• Γιώζζεο (Languages) 
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3.3.2.    Πξόηππα (Templates) 
 

Σα Templates, είλαη έλα είδνο επέθηαζεο ηνπ Joomla, ηα νπνίν νπζηαζηηθά είλαη 

ην Design ηηο ζειίδαο. Καζνξίδνπλ ην πώο εκθαλίδεηαη κία ζειίδα (ην ρξώκα ηεο 

ζειίδαο, ην κέγεζνο, ηνλ ηύπν ησλ δηαθόξσλ  γξακκαηνζεηξώλ πνπ πεξηέρεη ή ζα 

πεξηέρεη ε ζειίδα, αιιά θαη ηελ ηνπνζέηεζε ησλ Modules θαη ησλ Component ζηελ 

ζειίδα θιπ). Τπάξρεη πιεζώξα έηνηκσλ δηαζέζηκσλ Templates ηα νπνία κπνξνύκε λα 

βξνύκε ζην δηαδίθηπν γξάθνληαο απιά ζε έλα Browser “Templates for Joomla”. Αλ 

πιεθηξνινγήζνπκε “Templates for Joomla free” ζα βξνύκε Templates πνπ 

δηαηίζεληαη δσξεάλ Youtube (4). 

3.3.3.     Δθαξκνγέο (Components) 

Σα Components είλαη βαζηθέο επεθηάζεηο ηνπ Joomla. Σα Components πνπ 

ρξεζηκνπνηήζακε ζηελ ζειίδα καο είλαη ην Component γηα ηα άξζξα ηo νπνίν 

ρξεηάδεηαη γηα ηελ εκθάληζε ησλ άξζξσλ ζηελ ζειίδα καο, ην Component Akeeba 

Backup, ηνλ θεηκελνγξάθν JCE Editor θαη κία θόξκα επηθνηλσλίαο θαη ηα νπνία 

αλαθέξνπκε ζηελ ζπλέρεηα ηεο πηπρηαθήο καο εξγαζίαο. ΢ηα Templates κόλν έλα 

Component είλαη ελεξγό θάζε θνξά ζε κία ζειίδα. Σν Component βαζίδεηαη ζην 

κελνύ γηα ηελ εκθάληζή ηνπ θαη κέζα από ηηο ξπζκίζεηο ηνπ κελνύ είλαη θαη νη 

ξπζκίζεηο ηνπ Component θαη ππάξρνπλ πνιιέο ξπζκίζεηο γηα έλα Component, 

Δπίζεο ην Component έρεη κία θαη κνλαδηθή ζέζε ζην Template Youtube (17). 

3.3.4.   Δλζέκαηα (Modules) 
 

Σα Modules είλαη πξνγξάκκαηα ηα νπνία εθηεινύλ εξγαζίεο, όπσο είλαη ε 

εκθάληζε ελόο εκεξνινγίνπ, ην πεδίν αλαδήηεζεο (όπνπ κπνξνύκε λα αλαδεηήζνπκε 

πιεξνθνξίεο), ε εκθάληζε θηλνύκελσλ εηθόλσλ ή gallery, ε θόξκα επηθνηλσλίαο γηα 

ζύλδεζε θιπ. Δίλαη ζηνηρεία ηα νπνία εκθαλίδνληαη ζε ζέζεηο πνπ έρεη νξίζεη ην 

Template εθηειώληαο θάπνηα ζπγθεθξηκέλε ιεηηνπξγηθόηεηα sch (5). 

3.3.5.    Πξόζζεηα (Plugins) 

Σα Plugins είλαη επεθηάζεηο ηνπ ππόβαζξνπ (background) ηνπ Joomla θαη ηα 

νπνία βειηηώλνπλ  ηηο ιεηηνπξγηθέο δπλαηόηεηεο ηνπ ζπζηήκαηνο. Σν WikiBot, γηα 

παξάδεηγκα, επηηξέπεη ζην Γεκηνπξγό πεξηερνκέλνπ ζην Joomla λα ρξεζηκνπνηήζεη 

«Wikitags» ζηα άξζξα ηνπ, δειαδή εηηθέηεο (tags) νη νπνίεο δεκηνπξγνύλ απηόκαηα 
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δπλακηθνύο ππεξζπλδέζκνπο (hyperlinks) ζε αληίζηνηρα άξζξα ζηε Wikipedia  sch 

(5). 

3.3.6.    Γιώζζεο (Languages) 
 

Οη γιώζζεο είλαη έλα είδνο επέθηαζεο πνπ εκθαλίδεηαη θαη ζην Frontend αιιά 

θαη ζην Backend ηκήκα ηνπ Joomla. 

 

3.4.     Δγθαηάζηαζε αξρείωλ  ζην πεξηβάιινλ ηνπ Joomla 

 
Γηα ηελ εγθαηάζηαζε αξρείσλ ζην Joomla από ηελ πεξηνρή δηαρείξηζεο ηνπ Joomla 

ζηε γξακκή Μελνύ, επηιέγνπκε Extensions > Manage > Install όπσο δείρλεη ε 

παξαθάησ εηθόλα 14. 

 

Εικόνα 14  Εγκατάςταςη αρχείων ςτο περιβάλλον του Joomla 

Από ηελ επηινγή Upload Package File, επηιέγνπκε ην θνπκπί Δπηινγή αξρείνπ, 

επηιέγνπκε ην αξρείν πνπ επηζπκνύζακε από ηνλ ππνινγηζηή καο σο επέθηαζε .zip 

θαη παηάκε ην θνπκπί Upload & Install. Η επηηπρήο εγθαηάζηαζε ηνπ αξρείνπ ζην 

πεξηβάιινλ ηνπ Joomla επηβεβαηώλεηαη κε ζρεηηθό κήλπκα. 
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ΚΔΦΑΛΑΙΟ 4 

Καηαζθεπή ηζηνζειίδαο 

4.1.    Δγθαηάζηαζε Template 

Γηα λα δεκηνπξγήζνπκε ηελ ηζηνζειίδα καο ρξεζηκνπνηήζακε έλα από ηα δσξεάλ 

παξερόκελα πξόηππα (Templates) ην νπνίν ην αλαδεηήζακε ζην δηαδίθηπν  

Η επηινγή ελόο πξνηύπνπ, κέζα από ρηιηάδεο πξόηππα πνπ έρνπλ δεκηνπξγεζεί 

θαη βξίζθνληαη εύθνια αλαδεηώληαο Templates for Joomla ζην δηαδίθηπν, γηα 

δεκηνπξγία ηζηνζειίδαο, είλαη πξνθαλώο δηθαίσκα ηνπ θαηαζθεπαζηή ηεο 

ηζηνζειίδαο.  

Σα δσξεάλ παξερόκελα πξόηππα έρνπλ νξηζκέλα κεηνλεθηήκαηα όπσο: 

•     Ο δεκηνπξγόο ηνπο δελ δίλεη ππνζηήξημε γηα ην πξόηππν, δειαδή αλ ηνπ 

ζηείινπκε κήλπκα γηα θάπνηα απνξία ζρεηηθά κε ην πξόηππν, κπνξεί θαη λα 

κελ καο απαληήζεη. 

•     ΢πλήζσο δελ έρνπλ πνιιέο ζέζεηο γηα Modules. 

•     Δπίζεο κπνξεί λα κελ ιεηηνπξγνύλ ζε όινπο ηνπο Browsers. Έλα δσξεάλ 

πξόηππν γηα παξάδεηγκα λα ιεηηνπξγεί ζηνλ Google Chrome θαη λα κελ 

ιεηηνπξγεί ζηνλ Internet Explorer. 

Σα εκπνξηθά αληηζέησο έρνπλ θάπνην θόζηνο αγνξάο, αιιά δηαζέηνπλ ππνζηήξημε 

από ηνλ θαηαζθεπαζηή, είλαη πξνζαξκνζκέλα αλάινγα κε ηελ εθαξκνγή ζηελ νπνία 

ζα αλαθέξεηαη ε ηζηνζειίδα θαη είλαη ζρεδηαζκέλα γηα λα ππνζηεξίδνληαη ζρεδόλ από 

ην ζύλνιν ησλ Browsers.   

Βέβαηα ππάξρνπλ θαη πνιύ θαιά δσξεάλ πξόηππα. Δκείο ζηελ πξνθεηκέλε 

πεξίπησζε ρξεζηκνπνηήζακε ην Helix3 Framework, ην νπνίν όπσο αλαθέξακε είλαη 

δσξεάλ θαη ην θαηεβάζακε από ηελ ηζηνζειίδα joomshaper (6).  

Αθνύ θαηέβεη ην Template κεηαβαίλνπκε ζην δηαρεηξηζηηθό ηνπ Joomla 

επηιέγνπκε από ηελ γξακκή Μελνύ Extensions > Manage > Install ή θαηεπζείαλ 

Extensions > Manage. Παηάκε Δπηινγή αξρείνπ γηα λα βξνύκε θαη λα επηιέμνπκε ην 

αξρείν ηνπ Template , ην νπνίν είλαη ζηηο ιήςεηο. Παηάκε Άλνηγκα θαη θάλνπκε click 

ζην θνπκπί  Upload & Install.  
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Η εγθαηάζηαζε ηνπ Template ήηαλ επηηπρήο αιιά αλνίγνληαο ηελ θεληξηθή 

ζειίδα παξαηεξνύκε όηη δελ εκθαλίζηεθε ην Template πνπ αλεβάζακε (δειαδή ην 

helix3) γηαηί δελ είλαη νξηζκέλν σο default Template ηεο ζειίδαο καο. 

Γηα λα θαηαζηίζνπκε ην helix3 default Template θαη λα εκθαληζηεί ζην Frontend 

ηκήκα ζηελ πεξηνρή δηαρείξηζεο ηνπ Joomla επηιέγνπκε Extensions > Templates, 

εκθαλίδνληαη όια ηα Templates πνπ είλαη εγθαηεζηεκέλα, εληνπίδνπκε ην helix3 θαη 

ην θάλακε default. ΢ηε ζπλέρεηα αλνίγνπκε ηελ θεληξηθή ζειίδα θαη παξαηεξνύκε όηη 

εκθαλίδεηαη ην Template helix3. 

Γελ μερλάκε λα ελεξγνπνηήζνπκε ηελ εκθάληζε ησλ ζέζεσλ ηνπ Template καο γηα 

ηελ εηζαγσγή ζε απηέο αληηθεηκέλσλ πνπ ρξεηαδόκαζηε γηα ηελ ηζηνζειίδα (Αrticles, 

Μodules, Component, Plugins). Δπηιέγνπκε από ην δηαρεηξηζηηθό ηνπ Joomla 

Extensions > Templates > Styles > Options θαη ζηελ επηινγή Preview Module 

Positions ελεξγνπνηνύκε ην Enabled αληί ηνπ Disabled πνπ πξνϋπήξρε. 

΢ην Template εκθαλίζηεθαλ δηάθνξα ζηνηρεία Μελνύ. Δκείο θξαηήζακε κόλν ην 

ΗΟΜΔ ηνπ νπνίνπ αιιάμακε ην όλνκα ηνπ ζε ΑΡΥΙΚΗ θαη όια ηα ππόινηπα ηα 

απελεξγνπνηήζακε γηα λα δεκηνπξγήζνπκε θαηλνύξγηα.  

 

4.2.    Δγθαηάζηαζε ειιεληθήο γιώζζαο 
 

Σν δηαρεηξηζηηθό ηνπ Joomla είρε πξνεγθαηεζηεκέλε ηελ αγγιηθή γιώζζα. 

Δπεηδή ε ηζηνζειίδα καο ζέιακε λα εκθαλίδεηε θαη ζηα ειιεληθά εγθαηαζηήζακε θαη 

ηελ ειιεληθή γιώζζα. Η πνξεία πνπ αθνινπζήζακε γηα λα εγθαηαζηήζνπκε ηελ 

ειιεληθή γιώζζα είλαη ε εμήο: Αξρηθά από ηελ πεξηνρή δηαρείξηζεο ηνπ Joomla 

επηιέγνπκε Extensions > Language(s) > Installed θαη δηαπηζηώλνπκε όηη είλαη 

εγθαηεζηεκέλε κόλν ε αγγιηθή γιώζζα. Μεηαβαίλνπκε ζην Mελνύ Help > Joomla! 

Translations γηα λα θαηεβάζνπκε ηελ ειιεληθή γιώζζα. Μαο εκθαλίδεηαη ε εηθόλα 15 

θαη επηιέγνπκε ηελ πξώηε έθδνζε, γηαηί ην Joomla καο είλαη ζπκβαηό κε ηελ έθδνζε 

3.x. 
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Εικόνα 15  Εγκατάςταςη ελληνικήσ γλϊςςασ επιλζγοντασ την ςυμβατή ζκδοςη για το Joomla 

Μεηά ηελ επηινγή εκθαλίδεηαη ε ζειίδα κε ηηο δηαζέζηκεο γιώζζεο. Γηα 

δηεπθόιπλζε αλαδήηεζεο ηεο ειιεληθή γιώζζαο παηάκε control+f  ώζηε λα καο 

βγάιεη παξάζπξν αλαδήηεζεο πάλσ δεμηά ζην νπνίν πιεθηξνινγνύκε greek θαη κεηά 

παηάκε enter. ΢ηελ ζπλέρεηα επηιέγνπκε ην link ην νπνίν είλαη θάησ από ην 

Download Language Pack , όπσο δείρλεη ε εηθόλα 16. 

  

Εικόνα 16  Επιλογή του πακζτου τησ ελληνική γλϊςςασ  

 

΢ηελ ζηήιε Filename ηεο ζειίδαο πνπ εκθαλίδεηαη επηιέγνπκε ηελ πξώηε 

έθδνζε θαη κε Download  πεξηκέλνπκε λα θαηέβεη ην αξρείν. 

Όηαλ ε ιήςε ηνπ αξρείνπ ηεο γιώζζαο νινθιεξσζεί επηιέγνπκε ζηελ 

πεξηνρή δηαρείξηζεο Extensions >   Manage > Install (ή απιά Extensions > Manage). 
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΢ηε ζειίδα πνπ εκθαλίδεηαη επηιέγνπκε Choose File θαη αθνύ εληνπίζνπκε 

ζηηο ιήςεηο ην αξρείν el-GR_joomla_lang_full_3.6.3v2.zip ηεο ειιεληθήο γιώζζαο 

παηάκε άλνηγκα όπσο δείρλεη ε εηθόλα 17. 

 

Εικόνα 17  Ανζβαςμα του πακζτου τησ ελληνικήσ γλϊςςασ ςτο Joomla 

 

Δπηιέγνπκε Upload & Install, θαη ην αξρείν εγθαζίζηαηαη ζην Joomla. Γηα λα 

δηαπηζηώζνπκε  όηη ην αξρείν εγθαηαζηάζεθε ζην Joomla επηιέγνπκε Extensions > 

Language > Installed θαη ε ειιεληθή γιώζζα είλαη παξέα καδί κε ηελ αγγιηθή. Αλ 

επηζπκνύκε ην δηαρεηξηζηηθό ηνπ Joomla λα εκθαλίδεηαη ζηα Διιεληθά ζηελ 

θπιηόκελε κπάξα Site επηιέγνπκε Administrator.  
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Εικόνα 18  Από την κυλιόμενη μπάρα  επιλζγουμε Administrator 

 

΢ηελ εηθόλα πνπ εκθαλίδεηαη επηιέγνπκε Set default ηελ ειιεληθή γιώζζα. 

Απηόκαηα παξαηεξνύκε όηη ε πεξηνρή δηαρείξηζεο ηνπ Joomla εκθαλίδεηαη ζηα 

Διιεληθά.  

 

Εικόνα 19  Επιλογή ελληνικήσ γλϊςςασ 

 

4.3.    Δγθαηάζηαζε JCE Editor 
 

Σν Joomla δηαζέηεη θεηκελνγξάθν γηα ηελ δεκηνπξγία άξζξσλ ζηελ 

ηζηνζειίδα καο ηνλ Δditor – TinyMCE. Όκσο έρνπκε ηελ δπλαηόηεηα λα επηιέμνπκε 

έλαλ θαιύηεξν θεηκελνγξάθν κε πεξηζζόηεξα εξγαιεία θαη πεξηζζόηεξεο 
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δπλαηόηεηεο, ώζηε λα δηεπθνιπλζνύκε ζε θαιύηεξε παξνπζίαζε ησλ άξζξσλ. O 

Editor πνπ θαηεβάζακε είλαη ν JCE Editor πνπ δηαηίζεηαη δσξεάλ θαη ηνλ θαηεβάζακε 

από ηελ ηζηνζειίδα  JCE Editor (7). 

Όηαλ νινθιεξσζεί ε ιήςε ηνπ αξρείνπ ηνπ JCE Editor κεηαβαίλνπκε ζηελ 

πεξηνρή δηαρείξηζεο ηνπ Joomla θαη επηιέγνπκε Extensions > Manage > Install γηα 

ηελ εγθαηάζηαζε ηνπ ζηελ πεξηνρή δηαρείξηζεο ηνπ Joomla. Ο JCE Editor 

εγθαηαζηάζεθε επηηπρώο, αιιά γηα λα ηνλ ρξεζηκνπνηήζνπκε ρξεηάδεηαη λα ηνλ 

πξνεπηιέμνπκε σο αξρηθό θεηκελνγξάθν. Δπηιέγνπκε System > Global Configuration 

θαη από ηνπο εγθαηεζηεκέλνπο Editors ζηελ επηινγή Default Editor επηιέγνπκε ηνλ 

JCE Editor σο Default όπσο θαίλεηαη ζηελ εηθόλα 20. 

 

Εικόνα 20  Εφρεςη του JCE Editor  

Αθνινύζσο παηάκε Save & Close θαη από εδώ θαη πέξα ηα άξζξα καο ζα 

γξάθνληαη κε ηνλ JCE Editor.  

4.4.    Γεκηνπξγία άξζξνπ 
 

Γηα λα δεκηνπξγήζνπκε έλα άξζξν αθνινπζνύκε ηα εμήο ηξία βήκαηα: 

• Γεκηνπξγία κίαο θαηεγνξίαο γηα ην άξζξν. 

• ΢πγγξαθή ηνπ άξζξνπ. 

• Γεκηνπξγία ζηνηρείνπ Μελνύ γηα ηελ εκθάληζε ηνπ άξζξνπ. 
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Δκείο ζηελ πξώηε ζειίδα ηηο ηζηνζειίδα καο δεκηνπξγήζακε ηξία άξζξα θαη 

κάιηζηα ηα εκθαλίζακε ην έλα δίπια ζην άιιν, δειαδή ζε ηξείο ζηήιεο.  

Η δεκηνπξγία κηαο θαηεγνξίαο γίλεηε σο εμήο: ΢ην δηαρεηξηζηηθό ηνπ Joomla 

επηιέγνπκε Content > Categories > New ή επηιέγνπκε θαηεπζείαλ Content > 

Categories > Add New Category. 

Δκθαλίδεηαη ε εηθόλα 21 ζηελ νπνία δεηά λα ζπκπιεξώζνπκε έλα όλνκα (Title 

*). Δκείο ηα ηξία άξζξα πνπ δεκηνπξγήζακε ηα εληάμακε ζε κία θαηεγνξία κε όλνκα 

Αξρηθή. 

 

Εικόνα 21  Δημιουργία μιασ κατηγορίασ με όνομα Αρχική 

΢ην πεδίν Title * πιεθηξνινγνύκε Αξρηθή. Δπίζεο εηζάγνπκε θαη ζην πεδίν 

Alias έλα ςεπδώλπκν κε όλνκα arxiki έηζη ώζηε ε Google λα κελ βάιεη απηόκαηα έλα 

default από κόλε ηεο πνπ ελδερνκέλσο λα είλαη άζρεην κε απηό πνπ πεξηγξάθεη.  

Σηο άιιεο επηινγέο ηηο αθήλνπκε σο έρεη θαη παηάκε Save & Close. 

Η επηηπρήο απνζήθεπζε ηεο θαηεγνξίαο Αξρηθή επηβεβαηώλεηαη κε κήλπκα. 

Γηα λα δεκηνπξγήζνπκε έλα άξζξν από ην δηαρεηξηζηηθό ηνπ Joomla 

επηιέγνπκε Content > Articles >   New ή θαηεπζείαλ Content > Articles > Add New 

Article. 

Δκθαλίδεηαη ε  εηθόλα 22. 
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Εικόνα 22  Δημιουργία και ςυγγραφή του ίδιου του άρθρου 

΢ηελ θπιηόκελε κπάξα Category * επηιέγνπκε σο θαηεγνξία ηελ Αξρηθή. 

΢ην πεδίν Title *, δειαδή ζηνλ ηίηιν ηνπ άξζξνπ, εηζάγνπκε ην όλνκα ηνπ 

άξζξνπ πνπ γηα ην πξώην καο άξζξν είλαη Βίια θαη ρξεζηκνπνηώληαο ηα εξγαιεία ηνπ 

θεηκελνγξάθνπ γξάθνπκε θαη κνξθνπνηνύκε ην θείκελν ηνπ άξζξνπ.  

Η ζέζε θαη ε κνξθή εκθάληζεο ελόο άξζξνπ ζε κία ζειίδα είλαη επηινγή ηνπ 

δεκηνπξγνύ ηεο. ΢ε νξηζκέλεο ζειίδεο ην άξζξν εκθαλίδεηε νιόθιεξν θαη ζε άιιεο 

εκθαλίδεηαη κέξνο απηνύ, κε παξαπνκπή γηα εκθάληζε νιόθιεξνπ ηνπ άξζξνπ. 

Δπεηδή εκείο ζηελ ζειίδα καο ζέινπκε λα εκθαλίζνπκε ηξία άξζξα κεγάινπ κεγέζνπο  

ηαπηόρξνλα ζε ηξεηο ζηήιεο θαη λα εηζάγνπκε θσηνγξαθία ζε θάζε άξζξν επηιέμακε 

λα εκθαλίδεηαη κέξνο από θάζε άξζξν κε παξαπνκπή γηα εκθάληζε νιόθιεξνπ.  

Αθνύ γξαθεί ην άξζξν ηνπνζεηνύκε ηνλ θέξζνξα ζε ζεκείν, όπνπ εκείο 

επηζπκνύκε, πνπ ρσξίδεη ην κέξνο ηνπ άξζξνπ πνπ ζα εκθαλίδεηαη ζηελ θεληξηθή 

ζειίδα. Δπηιέγνπκε ζην ηέινο ηνπ παξαζύξνπ ηνπ άξζξνπ από ηα έμη θνπκπηά πνπ 

πεξηιακβάλεη εθείλν πνπ γξάθεη ζηα αγγιηθά Read More ή πην απιά θάλνπκε click 

πάλσ από ην άξζξν ζην πξνηειεπηαίν εξγαιείν ηνπ θεηκελνγξάθνπ Insert Read More.  

Αθνινύζσο ζηελ επηινγή Options ηνπ θεηκελνγξάθνπ θαη ζην πξνηειεπηαίν 

πεδίν πνπ ιέεη Read More Text πιεθηξνινγνύκε ην θείκελν “Γηαβάζηε πεξηζζόηεξα” 

όπσο θαίλεηαη ζηελ εηθόλα 23 θαη έπεηηα επηιέγνπκε Save & Close. 
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Εικόνα 23  Πληκτρολόγηςη του κειμζνου διαβάςτε περιςςότερα ςτο πεδίο Read More text 

Σα επόκελα δύν άξζξα πνπ δεκηνπξγήζακε, αθξηβώο κε ηνλ ηξόπν πνπ 

πεξηγξάςακε παξαπάλσ, γηα ηελ ίδηα ζειίδα ηα εληάμακε ζηελ ίδηα θαηεγνξία Αξρηθή 

θαη ηνπο δώζακε νλόκαηα “King ζνπίηα” θαη “Πνιπηειήο ζνπίηα”.  

Φπζηθά ηα άξζξα ηα πήξακε από ηζηνζειίδεο μελνδνρείσλ, κε δηθέο καο 

ηξνπνπνηήζεηο θαη κάιηζηα ηα πεξηζζόηεξα από ηελ ηζηνζειίδα ionianvista (8).  

Γηα λα εκθαληζηνύλ ηα άξζξα ζηελ ηζηνζειίδα καο θαη κάιηζηα ζηελ πξώηε 

ζειίδα καο ηελ ΑΡΥΙΚΗ από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Menus > Main 

Menu θάλνπκε click ζην ζηνηρείν Μελνύ ΑΡΥΙΚΗ θαη εκθαλίδεηαη ε εηθόλα 24. 
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Εικόνα 24  Επιλογή ςτοιχείου μενοφ ΑΡΧΙΚΗ για την εμφάνιςη των άρθρων μασ 

΢ηελ επηινγή Details ζην πεδίν Menu Item Type *  επηιέγνπκε Select, ζην 

παξάζπξν πνπ εκθαλίδεηαη επηιέγνπκε Articles θαη εκθαλίδεηαη ε εηθόλα 25. 

 

Εικόνα 25 Επιλογή Category Blog για την ειςαγωγή των άρθρων ςτην ίδια ςελίδα 

Δπηιέγνπκε Category Blog ώζηε λα εηζάγνπκε ηα άξζξα καο ζηελ ίδηα ζειίδα. 

΢ηελ επηινγή Choose a Category * επηιέγνπκε ηελ θαηεγνξία Αξρηθή. 
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Γηα ηελ εκθάληζε ησλ ηξηώλ άξζξσλ καο ην έλα δίπια ζην άιιν ζε ηξείο 

ζηήιεο θαη όρη ην έλα θάησ από ην άιιν επηιέγνπκε ην Blog Layout θαη 

ζπκπιεξώλνπκε ηηο ηηκέο ζηα παξαθάησ πεδία όπσο θαίλεηαη ζηελ εηθόλα 26. 

 

Εικόνα 26  Ρυθμίςεισ οριςμζνων πεδίων ςτο Blog Layout για να εμφανιςτοφν τα άρθρα το ζνα 

δίπλα ςτο άλλο 

΢ην πεδίν # Leading Articles πιεθηξνινγνύκε 0, γηαηί ζέινπκε λα κελ 

πεξηέρεη θαλέλα άξζξν επηθεθαιίδα, ζην πεδίν # Intro Articles πιεθηξνινγνύκε 3, 

γηαηί ν αξηζκόο ησλ άξζξσλ πνπ ζα εκθαληζηνύλ είλαη ηξία θαη ζην πεδίν # Columns 

πιεθηξνινγνύκε 3, γηαηί ζέινπκε ηα άξζξα καο λα εκθαληζηνύλ ην έλα δίπια ζην 

άιιν ζε ηξεηο ζηήιεο θαη επηιέγνπκε Save & Close. 

4.4.1.   Image Gallery Module 

Δπεηδή ηα άξζξα καο αθνξνύζαλ επηινγέο δηακνλήο ζην μελνδνρείν καο ζα 

ζέιακε ζε θάζε άξζξν λα κπνξνύκε λα εκθαλίδνπκε έλα ζύλνιν από εηθόλεο πνπ ζα 

ην πεξηγξάθνπλ γηα λα έρεη ν πειάηεο κία πιήξε εηθόλα γηα ηηο αλέζεηο πνπ ζα ηνπ 

πξνζθεξζνύλ. Γηα απηό ζε θάζε άξζξν θάλακε εηζαγσγή ελόο Μodule πνπ κπνξεί λα 

ρξεζηκνπνηήζεη ην Joomla θαη κάιηζηα παξέρεηε δσξεάλ, ην Image Gallery Module. 

Σν Image Gallery Module εκθαλίδεη έλα ζύλνιν εηθόλσλ πνπ βξίζθνληαη ζε έλα 

αξρείν κε επηινγέο, πξνεγνύκελε, επόκελε θαη κεγέζπλζε κε έλα θιηθ. Απηό ην 

Module ην θαηεβάζακε από ηελ ηζηνζειίδα ηνπ Joomla (1). Αθνύ ην θαηεβάζνπκε 

θαη ην εγθαηαζηήζνπκε ζηα Modules ηνπ Joomla κπνξνύκε λα παξαηεξήζνπκε όηη 

έρεη εγθαηαζηαζεί επηηπρώο επηιέγνληαο ζην δηαρεηξηζηηθό ηνπ Joomla Extensions > 

Modules θαη ζα ην δνύκε κε ην όλνκά ηνπ. 
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Δπηιέμακε λα θηηάμνπκε αξρεία εηθόλσλ γηα θάζε άξζξν από ηηο εηθόλεο πνπ 

επηιέμακε από δηάθνξεο ηζηνζειίδεο μελνδνρείσλ θαη θπξίσο από ην 

www.ionianvista.com (8). Δπεηδή νη εηθόλεο δελ είραλ ην ίδην κέγεζνο θαη εκείο 

ζέιακε λα είλαη όιεο ηνπ ίδηνπ κεγέζνπο γηα λα εκθαλίδνληαη νκνηόκνξθα ζηελ 

ζειίδα καο επηζθεθζήθακε ηελ ηζηνζειίδα  www.simpleimageresizer.com (9) που ζχει 

το πξόγξακκα Simple Image Resizer γηα εύθνιε δηαρείξηζε ησλ εηθόλσλ θαη ηηο 

επεμεξγαζηήθακε έηζη ώζηε λα έρνπλ όιεο ηηο ίδηεο δηαζηάζεηο. 

Αθνύ έγηλαλ ίδην κέγεζνο όιεο νη εηθόλεο ζα πξέπεη ηώξα λα ηηο αλεβάζνπκε 

ζην Joomla. Γηα λα αλεβάζνπκε κία ε πεξηζζόηεξεο εηθόλεο ζην δηαρεηξηζηηθό ηνπ 

Joomla επηιέγνπκε Content > Media. ΢ηελ ζπλέρεηα δεκηνπξγνύκε έλαλ θάθειν γηα 

λα εηζάγνπκε ηηο εηθόλεο. Δπηιέγνπκε ην button Create New Folder πιεθηξνινγνύκε 

ην όλνκα ηνπ θαθέινπ ζηελ πξνθεηκέλε πεξίπησζε the_villa θαη παηάκε Create 

Folder. Η εηθόλα 27 δείρλεη ηελ δηαδηθαζία δεκηνπξγίαο ηνπ θαθέινπ the_villa. 

  

Εικόνα 27  Δημιουργία φακζλου  με όνομα the_villa 

  

Κάλνπκε click ζηνλ θάθειν. Σώξα είκαζηε ζε ζέζε λα αλεβάζνπκε ηηο 

εηθόλεο καο γηα ην άξζξν Bίια. Κάλνπκε click ζην θνπκπί Upload, παηάκε Δπηινγή 

αξρείσλ, επηιέγνπκε ηνλ θάθειν ζηνλ νπνίν είλαη απνζεθεπκέλεο νη εηθόλεο, παηάκε 

Άλνηγκα θαη ην θνπκπί Start Upload θαη δηαπηζηώλνπκε όηη νη εηθόλεο έρνπλ 

κεηαθεξζεί ζην θάθειν the_villa κε επηηπρία όπσο δείρλεη ε εηθόλα 28. 
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Εικόνα 28  Ανζβαςμα εικόνων ςτον φάκελο the_villa 

Παξαηεξνύκε όηη θάησ  από ηελ Δπηινγή αξρείσλ ππάξρεη επηζήκαλζε γηα ην 

κέγεζνο ησλ Upload files (Maximum Size: 10 MB). Μπνξνύκε βέβαηα λα αιιάμνπκε 

ην κέγεζνο απηό επηιέγνληαο από ην δηαρεηξηζηηθό ηνπ Joomla Components > JCE 

Editor >   Profiles > Default > Editor Parameters > Filesystem, αιιάδνπκε ην Upload 

file size (KB) ζην επηζπκεηό κέγεζνο θαη παηάκε Save & Close. 

Οη εηθόλεο καο απνζεθεύηεθαλ επηηπρώο θαη είλαη απνζεθεπκέλεο ζην θάθειν 

images/the_villa, γηαηί o θάθεινο the_villa αιιά θαη νπνηνζδήπνηε θάθεινο πνπ ζα 

δεκηνπξγεζεί ζηελ επηινγή Media ζα απνζεθεπηεί ζηνλ θάθειν images. 

Δπόκελε ελέξγεηα ν νξηζκόο ηεο ζέζεο κέζα ζην άξζξν πνπ ζα ηνπνζεηεζεί 

ην Image Gallery Module. Δπηιέγνπκε ην άξζξν Βίια θαη ζηελ ζέζε κεηά ηελ κπάξα 

„δηαβάζηε πεξηζζόηεξα‟ (γηαηί εθεί ζέινπκε λα εκθαλίδεηαη ην Module) 

πιεθηξνινγνύκε {loadposition villes}. Απηή ε πξόηαζε κέζα ζε αγθύιεο ζεκαίλεη 

όηη θνξηώλεηε κία ζέζε ζην άξζξν κε όλνκα villes. Αθνινύζσο παηάκε Save  & 

Close όπσο θαίλεηαη ζηελ εηθόλα 29. 
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Εικόνα 29  Φόρτωςη θζςησ {loadposition villes} μζςα ςτο άρθρο Βίλα 

Σειηθή ελέξγεηα ε ελεξγνπνίεζε ηνπ Image Gallery Module. Από ην 

δηαρεηξηζηηθό ηνπ  Joomla επηιέγνπκε Extensions > Modules. Αθνύ ην εληνπίζνπκε 

ην επηιέγνπκε θαη θάλνληαο Click εκθαλίδεηαη ε εηθόλα 30.  

 

Εικόνα 30  Εντοπιςμόσ του Image Gallery Module και απαραίτητεσ ρυθμίςεισ των πεδίων του για 

το άρθρο Βίλα 

΢ην πεδίν Title * νξίδνπκε ην όλνκα ηνπ Module „The Villa‟, ζην πεδίν Show 

Title επηιέγνπκε ην Hide γηα λα κελ εκθαληζηεί ν ηίηινο ηνπ Module, ζην πεδίν 

Images folder πιεθηξνινγνύκε images/the_villa (είλαη ην path ηνπ θαθέινπ πνπ είλαη 
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απνζεθεπκέλεο νη εηθόλεο) ζην πεδίν Position επηιέγνπκε ηελ ζέζε ηνπ Module, ε 

νπνία είλαη ε villes, γηαηί απηή είλαη ε ζέζε πνπ θνξηώζακε ζην άξζξν Βίια γηα λα 

ηνπνζεηεζεί ην Module . Έπεηηα ζηελ επηινγή Menu Assignment ζην πεδίν Module 

Assignment επηιέγνπκε Only the pages selected (δειαδή λα εκθαληζηεί κόλν ζηηο 

επηιεγκέλεο ζειίδεο) ηζεθάξνπκε ηελ ΑΡΥΙΚΗ, ζηα πεδία Preview image width θαη 

Preview image height πιεθηξνινγνύκε επηζπκεηέο ηηκέο 500 θαη 440 αληίζηνηρα θαη 

παηάκε Save & Close. 

Αθξηβώο ηελ ίδηα δηαδηθαζία ζα θάλνπκε θαη ζηα άιια δύν άξζξα (King 

ζνπίηα, Πνιπηειήο ζνπίηα) κε ηελ δηαθνξά αιιάδνπκε ηα νλόκαηα ησλ ζέζεσλ ησλ 

άξζξσλ ζε king θαη deluxe αληίζηνηρα, δεκηνπξγνύκε θαηλνύξγηνπο θαθέινπο κε 

θαηλνύξγηεο θσηνγξαθίεο γηα ηα άξζξα. δελ ρξεηάδεηαη λα εγθαηαζηήζνπκε μαλά ην 

Image Gallery Module. Από ην δηαρεηξηζηηθό ηνπ Joomla ζηελ επηινγή Extensions > 

Modules > New επηιέγνπκε ηνλ ηύπν ηνπ Module sigplus  SIGPLUS_DESCRIPTION 

όπσο δείρλεη ε εηθόλα 31. 

 

Εικόνα 31  Δημιουργία των υπολοίπων Image Gallery Modules επιλζγοντασ τον τφπο του Module 

sigplus SIGPLUS_DESCRIPTION 



Σταύροσ Μπαλιούςκασ Σελίδα 38 
 

4.4.2.    Δηζαγωγή εηθόλωλ ζε άξζξα. 

΢ηα άξζξα κπνξνύκε λα εηζάγνπκε εηθόλεο, ζε επηιεγκέλεο ζέζεηο θαη 

κάιηζηα όζεο ζέινπκε. Δκείο επηιέμακε θαη γηα ηα ηξία άξζξα λα  βάινπκε εηθόλα 

αλάκεζα ζηνλ ηίηιν ηνπ άξζξνπ θαη ην άξζξν.  

Γηα εηζαγσγή εηθόλαο ζην άξζξν Βίια αλάκεζα ζηνλ ηίηιν Βίια θαη ηνπ 

θεηκέλνπ από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Content > Articles, ην άξζξν 

Βίια, ηε ζέζε ηνπ άξζξνπ πνπ ζα εηζάγνπκε ηελ εηθόλα θαη θάλνπκε click ζην 

πιήθηξν ηνπ θεηκελνγξάθνπ Insert/Edit image. Δπηιέγνπκε από αξρείν εηθόλσλ ηελ 

εηθόλα πνπ ζέινπκε λα εκθαληζηεί θαη παηάκε Insert όπσο δείρλεη ε εηθόλα 32. 

 

Εικόνα 32  Επιλογή μιασ απλήσ εικόνασ και ειςαγωγή τησ ςτο άρθρο Βίλα 

 

Με ηελ επηινγή ηεο εηθόλαο αλαγξάθεηαη απηόκαηα ην path ηεο ζην πεδίν 

URL. ΢ην πεδίν Alternative Text γξάθνπκε έλα θείκελν πνπ ζα επηζπκνύζακε λα καο 

εκθαλίζεη ζε πεξίπησζε πνπ δελ βξεζεί ε εηθόλα, ζην πεδίν Dimensions εηζάγνπκε 

ηηο δηαζηάζεηο ηεο εηθόλαο, ζην πεδίν Alignment επηιέγνπκε Centre (γηα εκθάληζε ηεο 

εηθόλαο ζην θέληξν ηνπ άξζξνπ πάλσ από ην θείκελν) θαη παηάκε Insert. Έπεηηα 

παηάκε Save & Close.   
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Αθξηβώο ηελ ίδηα δηαδηθαζία αθνινπζνύκε γηα εηζαγσγή εηθόλαο ζηα άιια 

δύν άξζξα (King ζνπίηα, Πνιπηειήο ζνπίηα). Με ηελ νινθιήξσζε ηεο δηαδηθαζίαο 

ζηα άιια δύν άξζξα ε θεληξηθή καο ζειίδα έρεη ηελ παξαθάησ κνξθή: 

 

Εικόνα 33 Εμφάνιςη όλων των άρθρων ςτην κεντρική ςελίδα το ζνα δίπλα ςτο άλλο 

 

4.5.    Module JE Orbit SlideShow 

Μία πξνζεγκέλε ηζηνζειίδα πξέπεη λα πεξηέρεη ζηηο ζειίδεο ηεο Sliders, 

δειαδή ζε επηιεγκέλεο ζέζεηο ηεο ζειίδαο λα ελαιιάζζνληαη εηθόλεο, πεξηνδηθά, 

θείκελα, δηαθεκίζεηο θιπ. κε επηιεγκέλε ρξνληθή πεξίνδν κεηξεκέλε ζε ms. Δκείο 

ζηελ ηζηνζειίδα καο ρξεζηκνπνηήζακε Slider γηα ελαιιαγή θσηνγξαθηώλ.  

Τπάξρνπλ δηαζέζηκεο επεθηάζεηο SlideShow θαη κάιηζηα αξθεηέο νη νπνίεο 

δηαηίζεληαη δσξεάλ ζην δηαδίθηπν θαηάιιειεο γηα ην Joomla. ΢ηελ δηθή καο 

ηζηνζειίδα ρξεζηκνπνηήζακε ην Module JE Orbit SlideShow, ην νπνίν ην 

θαηεβάζακε από ηελ ηζηνζειίδα extensions (10). Αθνύ ην πξόγξακκα θαηέβεη ζηηο 

ιήςεηο ην εγθαζηζηνύκε ζηα Modules ηνπ Joomla κε δηαδηθαζία πνπ  έρνπκε 

αλαιπηηθά πεξηγξάςεη ζε πξνεγνύκελεο εγθαηαζηάζεηο πξνγξακκάησλ. Αθνινύζσο 

δεκηνπξγήζακε έλαλ θάθειν κε θσηνγξαθίεο ηηο νπνίεο ζέινπκε λα εκθαλίδεη ν 

Slider (ζηελ πεξίπησζή καο ηνλ νλνκάζακε change) θαη ηνλ εγθαηαζηήζακε ζην 

Content  > Media. 
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Γηα ηηο ξπζκίζεηο ηνπ  Module JE Orbit SlideShow από ην δηαρεηξηζηηθό ηνπ 

Joomla επηιέγνπκε Extensions > Modules   JE Orbit SlideShow θαη εκθαλίδεηαη  

εηθόλα 34. 

 

Εικόνα 34  Εντοπιςμό του  Module JE Orbit SlideShow και ρφθμιςη των επιλογϊν του 

Σν πεδίν Title * ην αθήλνπκε σο έρεη JE Orbit SlideShow, ζην πεδίν Show 

Title επηιέγνπκε Ηide γηαηί δελ ρξεηάδεηαη  λα εκθαλίδεηαη ν ηίηινο, ζην πεδίν 

Position επηιέγνπκε κία ζέζε ζην Template γηα ην Module, ζην πεδίν Timer Speed 

πιεθηξνινγνύκε 2000, ε επηζπκεηή δηάξθεηα εκθάληζεο κηαο εηθόλαο 2s θαη ζην 

πεδίν Animation Speed πιεθηξνινγνύκε 1000, πνπ ζεκαίλεη όηη κε ην πνπ  ζα 

ζηακαηήζεη ε πξώηε εηθόλα ζα θάλεη παύζε 1s γηα λα εκθαληζηεί ε επόκελε. Έπεηηα 

ζηελ επηινγή >>> Manage Slides <<< επηιέγνπκε ηηο εηθόλεο θαη ην πιήζνο ησλ 

εηθόλσλ πνπ ζέινπκε λα εκθαλίδεη ην Module. Δκείο επηιέμακε ηηο 8 εηθόλεο πνπ 

βξίζθνληαη ζηνλ θάθειν /images/change όπσο θαίλεηαη ζηελ εηθόλα 35. 
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Εικόνα 35  Επιλογή των Εικόνων που θα εμφανίςει το Module 

  

΢ηελ Menu Assignment επηιέμακε On all pages γηα λα εκθαλίδεηαη ζε όιεο ηηο 

ζειίδεο ηεο ηζηνζειίδαο καο θαη παηάκε Save & Close. 

Σειηθά ε ζειίδα καο εκθαλίδεηαη όπσο δείρλεη ε εηθόλα 36 όπνπ 

ελαιιάζζνληαη νη θσηνγξαθίεο ηνπ θαθέινπ change. 

 

Εικόνα 36  Εμφάνιςη του Module ΢την κεντρική ςελίδα 
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4.6.   Πξνζζήθε ηεζζάξωλ γθαιεξί 

Γηα λα εκπινπηίζνπκε ηελ ηζηνζειίδα καο επηιέμακε λα πξνζζέζνπκε αθόκα 

ηέζζεξα Image Gallery Module ζε άιιεο ζέζεο ηνπ Template. Δπηιέμακε λα βάινπκε 

12 θσηνγξαθίεο από ην μελνδνρείν θαη επεηδή ηα Image Galleries είλαη ηέζζεξα ζε 

θάζε έλα ζα βάινπκε λα εκθαλίδεη ηξεηο εηθόλεο. Τπελζπκίδνπκε όηη όιεο ηηο εηθόλεο 

ηηο έρνπκε θάλεη ίδησλ δηαζηάζεσλ νπόηε ζα μεθηλήζνπκε κε ην πξώην Image Gallery. 

Δπηιέγνπκε ινηπόλ από ην δηαρεηξηζηηθό ηνπ Joomla Content > Media, δεκηνπξγνύκε 

έλαλ θάθειν, όπσο έρνπκε πξναλαθέξεη ζρεηηθά κε ηελ δεκηνπξγία ηνπ, κε όλνκα 

gallery1 θαη αλεβάδνπκε εθεί ηηο ηξεηο πξώηεο εηθόλεο καο. Αθνινύζσο κε ηνλ ίδην 

ηξόπν δεκηνπξγνύκε άιινπο ηξεηο θαθέινπο gallery2, gallery3, gallery4 θαη 

ηνπνζεηνύκε ζε απηνύο ηξεηο θσηνγξαθίεο ζηνλ θαζέλα. 

Από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Extensions > Modules > New 

γηα λα δεκηνπξγήζνπκε δηαδνρηθά ηα ηέζζεξα Image Galleries. ΢ην πξώην δίλνπκε 

όλνκα sigplus_arxiki_0, Images folder ηνλ images/gallery1, ζην Show Title 

επηιέγνπκε Hide, Position ζέζακε bottom1, ζηελ επηινγή Menu Assignment ζην 

Module Assignment επηιέγνπκε Only the pages selected, επηιέγνπκε ην ζηνηρείν 

Mελνύ ΑΡΥΙΚΗ θαη παηάκε  Save & Close. Σα ζηνηρεία γηα ην πξώην Image Gallery 

θαίλνληαη ζηελ εηθόλα 37. 

   

Εικόνα 37 Δημιουργία και ρφθμιςη του πρϊτου Image Gallery Module 
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΢ην δεύηεξν δίλνπκε όλνκα sigplus_arxiki_1, Images folder ηνλ  

images/gallery2, ζην Show Title επηιέγνπκε Hide, Position ζέηνπκε bottom2, ζηελ 

επηινγή Menu Assignment ζην Module Assignment επηιέγνπκε Only the pages 

selected, επηιέγνπκε ην ζηνηρείν κελνύ ΑΡΥΙΚΗ θαη παηάκε  Save & Close. Σα 

ζηνηρεία γηα ην δεύηεξν Image Gallery θαίλνληαη ζηελ εηθόλα 38. 

 

Εικόνα 38  Δημιουργία και ρφθμιςη του δεφτερου Image Gallery Module 

΢ην ηξίην δίλνπκε όλνκα sigplus_arxiki_2, Images folder ηνλ  

images/gallery3, ζην Show Title επηιέγνπκε Hide, Position ζέηνπκε bottom3, ζηελ 

επηινγή Menu Assignment ζην Module Assignment επηιέγνπκε Only the pages 

selected, επηιέγνπκε ην ζηνηρείν Mελνύ ΑΡΥΙΚΗ θαη παηάκε  Save & Close. Σα 

ζηνηρεία γηα ην ηξίην Image Gallery θαίλνληαη ζηελ εηθόλα 39. 

 

Εικόνα 39  Δημιουργία και ρφθμιςη του τρίτου Image Gallery Module 
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΢ην ηειεπηαίν δίλνπκε όλνκα sigplus_arxiki_3, Images folder ηνλ  

images/gallery4, ζην Show Title επηιέγνπκε Hide, Position ζέηνπκε bottom4, ζηελ 

επηινγή Menu Assignment ζην Module Assignment επηιέγνπκε Only the pages 

selected, επηιέγνπκε ην ζηνηρείν Mελνύ ΑΡΥΙΚΗ θαη παηάκε  Save & Close. Σα 

ζηνηρεία γηα ην ηέηαξην θαη ηειεπηαίν Image Gallery θαίλνληαη ζηελ εηθόλα 40. 

 

Εικόνα 40 Δημιουργία και ρφθμιςη του τζταρτου Image Gallery Module 

Αλαλεώλνληαο ηελ ηζηνζειίδα καο εκθαλίδνληαη ηα ηέζζεξα Image Galleries 

όπσο δείρλεη ε εηθόλα 41. 

 

Εικόνα 41  Εμφάνιςη όλων των  Image Gallery Module ςτην κεντρική ςελίδα 

 



Σταύροσ Μπαλιούςκασ Σελίδα 45 
 

 4.7.   Γεκηνπξγία Module κε ηελ ρξήζε Module Custom  HTML 
 

Έρνπκε ηελ δπλαηόηεηα λα γξάθνπκε θείκελα πνπ ζέινπκε λα εκθαλίδνληαη 

ζηελ ηζηνζειίδα καο κε ρξήζε ηνπ Module Custom HTML. Από ην δηαρεηξηζηηθό ηνπ 

Joomla επηιέγνπκε Extensions  > Modules > New θαη από ηηο επηινγέο ηνπ Select a 

Module Type επηιέγνπκε Custom. Θα εκθαληζηεί ν Editor ζηνλ νπνίν γξάθνπκε ην 

θείκελν, όπσο δείρλεη ε εηθόλα 42. 

   

Εικόνα 42  Δημιουργία και ρφθμιςη Module Custom HTML 

Σν θείκελν πνπ ζέινπκε λα εκθαληζηεί είλαη νξηζκέλεο πιεξνθνξίεο ζρεηηθά 

κε ηελ επηθνηλσλία ηνπ μελνδνρείνπ καο. Δκείο γξάςακε ην θείκελν πνπ αθνινπζεί: 

Δπηθνηλωλήζηε καδί καο. 

 Κσλζηαληηλνππόιεσο 10, Πεξηζηέξη – Σ.Κ 12132 

Σειέθσλν: 2671025585 

Fax: 2671025585. 

Email: stbaliouskas@yahoo.gr 

΢πκπιεξώλνπκε ζην πεδίν title * έλα όλνκα π.ρ Γηεύζπλζε, ζην πεδίν Show 

Title επηιέγνπκε Hide, επεηδή δελ ζέινπκε λα εκθαλίδεηε ν ηίηινο, ζην πεδίν Position 

ηελ ζέζε footer1 ηνπ Template καο, ζην Menu Assignment  Module Assignment 

mailto:stbaliouskas@yahoo.gr
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επηιέγνπκε On all pages θαη παηάκε Save & Close. Κάλνληαο αλαλέσζε 

παξαηεξνύκε όηη ην θείκελν εκθαλίζηεθε όπσο ζέιακε θαη ην βιέπνπκε ζηελ Δηθόλα 

43. 

 

 

Εικόνα 43  Εμφάνιςη Module Custom HTML ςτην κεντρική ςελίδα 

 

4.8.   Πξνζζήθε λέωλ ζηνηρείωλ κελνύ. 

Μέρξη ηώξα ε ηζηνζειίδα καο πεξηέρεη κόλν ην ζηνηρείν κελνύ ΑΡΥΙΚΗ. Θα 

ζπλερίζνπκε δεκηνπξγώληαο  λέα απαξαίηεηα ζηνηρεία κελνύ πνπ πξέπεη λα έρεη ε 

ηζηνζειίδα καο. Κξίλακε απαξαίηεην λα ζπκπεξηιάβνπκε ζε απηά ηα: 

• ΠΑΡΟΥΔ΢ 

• ΦΩΣΟΓΡΑΦΙΔ΢ 

• ΚΡΑΣΗ΢ΔΙ΢ 

• ΣΟΠΟΘΔ΢ΙΑ 

• ΔΠΙΚΟΙΝΩΝΙΑ 

4.8.1.   Πξνζζήθε ζηνηρείνπ κελνύ ΠΑΡΟΥΔ΢. 
 

 Όπσο έρνπκε αλαθέξεη γηα λα δεκηνπξγεζεί έλα ζηνηρείν Μελνύ πξέπεη 

πξώηα λα δεκηνπξγήζνπκε έλα άξζξν. Σν άξζξν ην δεκηνπξγνύκε ζύκθσλα κε όζα 
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έρνπκε αλαθέξεη παξαπάλσ. Καηαξράο δεκηνπξγήζακε κία θαηεγνξία κε όλνκα 

Παξνρέο θαη ζηελ ζπλέρεηα δεκηνπξγήζακε έλα άξζξν κε όλνκα Παξνρέο θαη ην 

εληάμακε ζηελ θαηεγνξία Παξνρέο. Μεηά εκθαλίδνπκε ην άξζξν καο. Από ην 

δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Menus > Main Menu θαη παηάκε New. ΢ην 

Menu Title *  πιεθηξνινγνύκε ην όλνκα ηνπ ζηνηρείνπ κελνύ ην ΠΑΡΟΥΔ΢, ζην 

Menu Item Type επηιέγνπκε Single Article, γηαηί ηώξα ζέινπκε έλα άξζξν θαη όρη 

πεξηζζόηεξα όπσο πξηλ. Δπηιέγνπκε ην άξζξν θαη παηάκε Save & Close. 

Γηα λα εκπινπηίζνπκε ηελ ζειίδα ΠΑΡΟΥΔ΢ δεκηνπξγήζακε κία θαηεγνξία 

άξζξσλ γηα θεκηζκέλεο παξαιίεο ζηελ πεξηνρή ηνπ μελνδνρείνπ καο ηελ νπνία 

νλνκάζακε παξαιίεο θαη ζπκπεξηιάβακε ζε απηήλ ηηο παξαιίεο:  

• Η παξαιία ησλ Πεηαλώλ 

• Άκκεο 

• Αληίζακνο 

• Μαθξύο θαη Πιαηύο Γπαιόο 

• Μύξηνο 

Γηα ηελ εκθάληζε ησλ άξζξσλ απηήο ηεο θαηεγνξίαο ρξεζηκνπνηήζακε ην 

Articles – Category Module. 

Απηό ην Module εκθαλίδεη κία ιίζηα από άξζξα από κία θαηεγνξία ε πεξηζζόηεξεο 

θαηεγνξίεο. Από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Extensions >  Modules > 

New θαη ζην Select a Module Type επηιέγνπκε Articles – Category. Γίλνπκε όλνκα 

beach_module, ζηελ επηινγή Show Title επηιέγνπκε Hide. ΢ην πεδίν Position  

επηιέγνπκε ηελ ζέζε right  θαη ειέγρνπκε επίζεο ην Status λα πεξηέρεη ηελ επηινγή 

Published. ΢ηελ επηινγή Menu Assignment ζην πεδίν Module Assignment 

επηιέγνπκε Only the pages selected θαη επηιέγνπκε ηηο ΠΑΡΟΥΔ΢. ΢ηελ επηινγή 

Filtering Options, όπσο δείρλεη ε εηθόλα 44, ζην πεδίν Count  εηζάγνπκε ηελ ηηκή 0, 

γηα λα εκθαληζηνύλ όια ηα άξζξα, ζην πεδίν Category επηιέγνπκε ηελ θαηεγνξία 

παξαιίεο θαη παηάκε Save & Close. 
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Εικόνα 44  Δημιουργία και ρφθμιςή του Articles-Category Module 

Μεηά από όια ηα παξαπάλσ ε ζειίδα ΠΑΡΟΥΔ΢ ζα καο εκθαληζηεί όπσο 

δείρλεη ε εηθόλα 45, κε ηα 5 άξζξα ηεο θαηεγνξίαο παξαιίεο ζηα δεμηά ηνπ άξζξνπ 

Παξνρέο. 

  

 

Εικόνα 45  Εμφάνιςη των άρθρων ςτα δεξιά του άρθρου Παροχζσ 
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4.8.2.   Πξνζζήθε ζηνηρείνπ κελνύ ΦΩΣΟΓΡΑΦΙΔ΢ 
 

Σώξα ζα δεκηνπξγήζνπκε έλα ζηνηρείν Μελνύ γηα ηηο θσηνγξαθίεο καο. 

Δπηιέγνπκε ζην Menus > Main Menu > Add New Menu Item θαη δεκηνπξγνύκε έλα 

ζηνηρείν Μελνύ κε όλνκα ΦΩΣΟΓΡΑΦΙΔ΢ εηθόλα 46.  

 

Εικόνα 46  Δημιουργία του ςτοιχείου μενοφ ΦΩΣΟΓΡΑΦΙΕ΢ 

΢ην Menu Item Type * επηιέγνπκε ην External URL, ζην πεδίν Link 

πιεθηξνινγνύκε ην πιήθηξν #, γηαηί δελ ζέινπκε λα πεγαίλεη ζε άιιε ζειίδα, 

αληίζεηα ζέινπκε όηαλ θάλνπκε click λα κελ θάλεη ηίπνηα. Η επηινγή καο απηή έγηλε, 

γηαηί ζην ζηνηρείν κε όλνκα ΦΩΣΟΓΡΑΦΙΔ΢ ζα δεκηνπξγήζνπκε Τπνκελνύ κε 

ζηνηρεία πνπ έρνπλ όλνκα ΠΔΡΙΟΥΗ΢, ΞΔΝΟΓΟΥΔΙΟΤ θαη ΓΩΜΑΣΙΟΤ. ΢ην 

Τπνκελνύ ΠΔΡΙΟΥΗ΢ ζα βάινπκε Galleries θσηνγξαθηώλ από ηελ πεξηνρή ηνπ 

μελνδνρείνπ, ζην ΞΔΝΟΓΟΥΔΙΟΤ Galleries θσηνγξαθηώλ  από ην πεξηβάιινλ ηνπ 

μελνδνρείνπ θαη ηνπο εζσηεξηθνύο ηνπ ρώξνπο θαη ζην ΓΩΜΑΣΙΟΤ Galleries 

θσηνγξαθηώλ από ηνπο ρώξνπο ησλ δσκαηίσλ. 

4.8.2.1.   Τπνκελνύ ΠΔΡΙΟΥΗ΢ 
 

Γηα ην ζηνηρείν Τπνκελνύ ΠΔΡΙΟΥΗ΢ δεκηνπξγνύκε κία θαηεγνξία κε 

όλνκα Φσηνγξαθίεο πεξηνρήο, ζηελ νπνία θηηάρλνπκε έλα άξζξν κε όλνκα 

Φσηνγξαθίεο πεξηνρήο θαη κέζα ζην άξζξν εηζάγνπκε κία ζέζε κε όλνκα 

photos_area όπσο έρνπκε αλαθέξεη παξαπάλσ ζε άξζξα κε Galleries θαη παηάκε Save 

& Close. Καηόπηλ δεκηνπξγνύκε έλα θάθειν θάησ από ην images κε όλνκα island θαη 
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βάδνπκε ζε απηόλ 12 θσηνγξαθίεο ηηο πεξηνρήο ηνπ μελνδνρείνπ καο ηηο νπνίεο 

ζέινπκε λα εκθαλίδεη ε ζειίδα καο ζε 4 γξακκέο θαη 3 ζηήιεο. 

Έπεηηα ζην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Menus > Main Menu > Add 

New Menu Item  δεκηνπξγνύκε έλα λέν ζηνηρείν κελνύ κε όλνκα ΠΔΡΙΟΥΗ΢. ΢ην 

Menu Item Type * επηιέγνπκε ην Single Article (απιό άξζξν) , ζην Select Articles 

επηιέγνπκε ην άξζξν Φσηνγξαθίεο πεξηνρήο, ζην Parent Item  επηιέγνπκε ην ζηνηρείν 

κελνύ ΦΩΣΟΓΡΑΦΙΔ΢, πνπ ζεκαίλεη όηη ην ζηνηρείν Τπνκελνύ ΠΔΡΙΟΥΗ΢ ζα έρεη 

γνληθό ζηνηρείν ην ζηνηρείν κελνύ ΦΩΣΟΓΡΑΦΙΔ΢ θαη παηάκε Save & Close.   

Αθνινύζσο δεκηνπξγνύκε έλα Image Gallery Module κε ηνλ ηξόπν πνπ 

έρνπκε πξναλαθέξεη κε όλνκα fotos_area  όπσο δείρλεη ε εηθόλα 47. 

 

Εικόνα 47  Δημιουργία Image Gallery Module με όνομα fotos_area για το άρθρο Φωτογραφίεσ 

περιοχήσ 

΢ην πεδίν Show Title επηιέγνπκε Hide, ζην Images folder ζα βάινπκε ην 

images/island, ζηα πεδία Rows θαη Columns ζα βάινπκε ηηο ηηκέο 4 θαη 3 αληίζηνηρα, 

ζηα πεδία Preview image width θαη Preview image height ζα βάινπκε ηηο ηηκέο 300 

θαη 250 αληίζηνηρα θαη ζην πεδίν Position επηιέγνπκε ηελ ζέζε  photos_area .  ΢ηελ 

επηινγή Menu Assignment ζην Module Assignment επηιέγνπκε Only the pages 

selected, επηιέγνπκε λα εκθαλίδεηαη κόλν ζην ζηνηρείν ππνκελνύ ΠΔΡΙΟΥΗ΢ ηνπ 

Main Menu θαη παηάκε Save & Close. Σν απνηέιεζκα ησλ παξαπάλσ ελεξγεηώλ 

θαίλεηαη ζηελ εηθόλα 48 ηεο ζειίδαο ΦΩΣΟΓΡΑΦΙΔ΢/ ΠΔΡΙΟΥΗ΢. 
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Εικόνα 48 Εμφάνιςη του Image Gallery Module fotos_area ςε rows 4 και columns 3 ςτην κεντρική 

ςελίδα 

 

4.8.2.2.   Τπνκελνύ ΞΔΝΟΓΟΥΔΙΟΤ 

Όπσο θηηάμακε ην πξνεγνύκελν ππνκελνύ ΠΔΡΙΟΥΗ΢ ηα ίδηα αθξηβώο 

βήκαηα θάλνπκε γηα λα δεκηνπξγήζνπκε ην ππνκελνύ ΞΔΝΟΓΟΥΔΙΟΤ θαη 

ΓΩΜΑΣΙΩΝ πνπ ζα αθνινπζήζεη. 

Πξώηα δεκηνπξγνύκε κία θαηεγνξία κε όλνκα Φσηνγξαθίεο μελνδνρείνπ, 

ζηελ νπνία δεκηνπξγνύκε έλα άξζξν κε όλνκα Φσηνγξαθίεο μελνδνρείνπ θαη κέζα 

ζην άξζξν εηζάγνπκε κία ζέζε κε όλνκα photos_hotel όπσο έρνπκε αλαθέξεη 

παξαπάλσ ζε άξζξα κε Galleries θαη παηάκε Save & Close. Καηόπηλ δεκηνπξγνύκε 

έλα θάθειν θάησ από ην images κε όλνκα fotos_hotel θαη βάδνπκε ζε απηόλ 12 

θσηνγξαθίεο ηνπ μελνδνρείνπ καο ηηο νπνίεο ζέινπκε λα εκθαλίδεη ε ζειίδα καο ζε 4 

γξακκέο θαη 3 ζηήιεο . 

Έπεηηα δεκηνπξγνύκε έλα λέν ζηνηρείν κελνύ κε όλνκα ΞΔΝΟΓΟΥΔΙΟΤ. 

΢ην Menu Item Type * επηιέγνπκε ην Single Article (απιό άξζξν) ,ζην Select 

Articles επηιέγνπκε ην άξζξν Φσηνγξαθίεο μελνδνρείνπ, ζην Parent Item επηιέγνπκε 

ην ζηνηρείν κελνύ ΦΩΣΟΓΡΑΦΙΔ΢, πνπ ζεκαίλεη όηη ην ζηνηρείν ππνκελνύ 
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ΞΔΝΟΓΟΥΔΙΟΤ ζα έρεη γνληθό ζηνηρείν ην ζηνηρείν κελνύ ΦΩΣΟΓΡΑΦΙΔ΢ θαη 

παηάκε Save & Close.   

Αθνινύζσο δεκηνπξγνύκε έλα Gallery Module κε όλνκα Fwtografies_hotel. 

΢ην πεδίν Show Title επηιέγνπκε Hide, ζην Images folder πιεθηξνινγνύκε 

images/fotos_hotel, ζηα πεδία Rows θαη Columns ηηο ηηκέο 4 θαη 3 αληίζηνηρα, ζηα 

πεδία Preview image width θαη Preview image height ηηο ηηκέο 300 θαη 250 

αληίζηνηρα θαη ζην πεδίν Position επηιέγνπκε ηελ ζέζε  photos_hotel .  ΢ην Menu 

Assignment ζην Module Assignment επηιέγνπκε Only the pages selected, επηιέγνπκε 

λα εκθαλίδεηε κόλν ζην ζηνηρείν ππνκελνύ ΞΔΝΟΓΟΥΔΙΟΤ ηνπ Main Menu θαη 

παηάκε Save & Close .  

4.8.2.3.   Τπνκελνύ ΓΩΜΑΣΙΩΝ 
 

 Πξώηα δεκηνπξγνύκε κία θαηεγνξία κε όλνκα Φσηνγξαθίεο δσκαηίσλ, ζηελ 

νπνία ζα θηηάμνπκε έλα άξζξν κε όλνκα Φσηνγξαθίεο δσκαηίσλ θαη κέζα ζην άξζξν 

ζα εηζάγνπκε κία ζέζε κε όλνκα rooms όπσο έρνπκε αλαθέξεη παξαπάλσ ζε άξζξα 

κε Galleries θαη παηάκε Save & Close. Καηόπηλ δεκηνπξγνύκε έλα θάθειν θάησ από 

ην images κε όλνκα rooms θαη βάδνπκε ζε απηόλ 12 θσηνγξαθίεο από ηα δσκάηηα 

ηνπ μελνδνρείνπ καο ηηο νπνίεο ζέινπκε λα εκθαλίδεη ε ζειίδα καο . ζε 4 γξακκέο θαη 

3 ζηήιεο. 

Έπεηηα δεκηνπξγνύκε έλα λέν ζηνηρείν κελνύ κε όλνκα ΓΩΜΑΣΙΩΝ. ΢ην 

Menu Item Type * επηιέγνπκε ην Single Article, ζην Select Articles επηιέγνπκε ην 

άξζξν Φσηνγξαθίεο δσκαηίσλ, ζην Parent Item επηιέγνπκε ην ζηνηρείν κελνύ 

ΦΩΣΟΓΡΑΦΙΔ΢, πνπ ζεκαίλεη όηη ην ζηνηρείν ππνκελνύ ΓΩΜΑΣΙΩΝ ζα έρεη 

γνληθό ζηνηρείν ην ζηνηρείν κελνύ ΦΩΣΟΓΡΑΦΙΔ΢ θαη ζα παηάκε Save & Close.   

Αθνινύζσο δεκηνπξγνύκε έλα Gallery Module κε όλνκα rooms. ΢ην πεδίν 

Show Title  επηιέγνπκε Hide, ζην Images folder πιεθηξνινγνύκε  images/rooms, ζηα 

πεδία Rows θαη Columns ηηο ηηκέο 4 θαη 3 αληίζηνηρα, ζηα πεδία Preview image width 

θαη Preview image height ηηο ηηκέο 300 θαη 250 αληίζηνηρα θαη ζην πεδίν Position 

επηιέγνπκε ηελ ζέζε rooms. ΢ην Menu Assignment ζην Module Assignment 

επηιέγνπκε Only the pages selected, επηιέγνπκε λα εκθαλίδεηε κόλν ζην ζηνηρείν 

ππνκελνύ ΓΩΜΑΣΙΩΝ ηνπ Main Menu θαη παηάκε Save & Close .  



Σταύροσ Μπαλιούςκασ Σελίδα 53 
 

4.8.3.   Πξνζζήθε ζηνηρείνπ κελνύ ΚΡΑΣΗ΢ΔΙ΢ 

 

Σώξα ζα δεκηνπξγήζνπκε έλα ζηνηρείν κελνύ γηα λα κπνξνύλ νη πειάηεο καο 

λα θάλνπλ online θξαηήζεηο. Δπηιέγνπκε ζην Menus > Main Menu > Add New Menu 

Item * θαη θηηάρλνπκε έλα ζηνηρείν κελνύ κε όλνκα ΚΡΑΣΗ΢ΔΙ΢.  

Γελ ρξεηάδεηαη λα βάινπκε εηθόλα νζόλεο, γηαηί ε δεκηνπξγία ηνπ είλαη 

παξόκνηα κε ηελ δεκηνπξγία ηνπ κελνύ ΦΩΣΟΓΡΑΦΙΔ΢ 

΢ην Menu Item Type * επηιέγνπκε ην External URL, ζην πεδίν Link 

πιεθηξνινγνύκε ην πιήθηξν #,   γηαηί δελ ζέινπκε λα πεγαίλεη ζε άιιε ζειίδα, 

αληίζεηα ζέινπκε όηαλ θάλνπκε click λα κελ θάλεη ηίπνηα. Η επηινγή καο απηή έγηλε, 

γηαηί ζην ζηνηρείν κε όλνκα ΚΡΑΣΗ΢ΔΙ΢ ζα δεκηνπξγήζνπκε ππνκελνύ κε ζηνηρεία 

πνπ έρνπλ όλνκα ΒΙΛΑ, ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ θαη KING ΢ΟΤΙΣΑ. ΢ηα ππνκελνύ  

ζα δεκηνπξγήζνπκε άξζξα θαη ζα εηζάγνπκε έλα θαηλνύξγην Module ην νπνίν θάλεη 

online θξαηήζεηο από ηα πνιιά Modules πνπ δηαηίζεληαη ζην δηαδίθηπν, ην 

θαηεβάζακε από ηελ ηζηνζειίδα solidres (11) και παρζχεται δωρεάν. 

 

4.8.3.1.   Τπνκελνύ ΒΙΛΑ 
 

     Γηα λα δεκηνπξγήζνπκε ην ζηνηρείν ππνκελνύ ΒΙΛΑ  θηηάρλνπκε πξώηα κία 

θαηεγνξία  κε όλνκα Κάληε θξάηεζε γηα ηηο βίιεο καο, ζηελ νπνία δεκηνπξγνύκε έλα 

άξζξν κε όλνκα  Κάληε θξάηεζε γηα ηηο βίιεο καο, κέζα ζην άξζξν εηζάγνπκε κία 

ζέζε κε όλνκα reservation-vila, όπσο έρνπκε αλαθέξεη παξαπάλσ ζε άξζξα κε 

Modules θαη παηάκε Save & Close. Αθνινύζσο θάλνπκε εηζαγσγή ηνπ Module ζηε 

ζέζε πνπ δεκηνπξγήζακε ζην άξζξν θαη ξπζκίδνπκε ην Module όπσο δείρλεη ε 

εηθόλα 49. 
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Εικόνα 49  Ρφθμιςη του Solidres – Module check availability με όνομα Κάντε κράτηςη για τισ βίλεσ 

μασ 

΢ην πεδίν Title * εηζάγνπκε ην όλνκα ηνπ Module θάληε θξάηεζε γηα ηηο βίιεο 

καο, ζην πεδίν Show Title επηιέγνπκε Hide, γηα λα κελ εκθαληζηεί ν ηίηινο, ζην πεδίν 

Position επηιέγνπκε ηελ ζέζε reservation-vila, ζην πεδίν Target Itemid επηιέγνπκε ην 

ζηνηρείν Μελνύ ΒΙΛΑ, ζην Enable room quality ην αθήλνπκε yes, θαη ζηα πεδία Max 

room number, Max adult number, Max child number  επηιέγνπκε ηελ δηαζεζηκόηεηά 

καο 10. ΢ην Menu Assignment ζηε ζέζε Module Assignment επηιέγνπκε Only the 

pages selected, ζηε ζέζε Menu Selection θάλνπκε check ζην ΒΙΛΑ θαη παηάκε Save 

& Close. Αλ θάλνπκε αλαλέσζε ζα καο εκθαληζηεί ε εηθόλα 50. 

 

Εικόνα 50  Εμφάνιςη του Module  Κάντε κράτηςη για τισ βίλεσ μασ 
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4.8.3.2.   Τπνκελνύ ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ 
 

Όπσο θηηάμακε ην πξνεγνύκελν ππνκελνύ ΒΙΛΑ ηα ίδηα αθξηβώο βήκαηα θάλνπκε 

γηα λα δεκηνπξγήζνπκε ην ππνκελνύ ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ θαη KING ΢ΟΤΙΣΑ 

πνπ ζα αθνινπζήζεη. 

     Πξώηα δεκηνπξγνύκε κία θαηεγνξία κε όλνκα Κάληε θξάηεζε γηα ηηο πνιπηειείο 

ζνπίηεο καο, ζηελ νπνία θηηάρλνπκε έλα άξζξν κε όλνκα Κάληε θξάηεζε γηα ηηο 

πνιπηειείο ζνπίηεο καο κέζα ζην άξζξν εηζάγνπκε κία ζέζε κε όλνκα reservation-

deluxe όπσο έρνπκε αλαθέξεη παξαπάλσ ζε άξζξα κε Modules θαη παηάκε Save & 

Close. Αθνινύζσο θάλνπκε εηζαγσγή ηνπ Module ζηε ζέζε πνπ δεκηνπξγήζακε ζην 

άξζξν θαη ξπζκίδνπκε ην Module όπσο αθξηβώο θάλακε γηα ηελ ξύζκηζή ηνπ ζην 

ππνκελνύ ΒΙΛΑ κε ηε δηαθνξά όηη αιιάδνπκε ηνλ ηίηιν ζε Κάληε θξάηεζε γηα ηηο 

πνιπηειείο ζνπίηεο καο, ην Target Itemid ζε ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ, Position 

reservation-deluxe θαη ζην Menu Assignment ζην Menu Selection θάλνπκε check ζην 

ζηνηρείν κελνύ ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ . 

4.8.3.3.   Τπνκελνύ KING ΢ΟΤΙΣΑ 
 

Γεκηνπξγνύκε κία θαηεγνξία κε όλνκα Κάληε θξάηεζε γηα ηηο king ζνπίηεο 

καο, ζηελ νπνία θηηάρλνπκε έλα άξζξν κε όλνκα Κάληε θξάηεζε γηα ηηο king ζνπίηεο 

καο κέζα ζην άξζξν εηζάγνπκε κία ζέζε κε όλνκα reservation-king όπσο έρνπκε 

αλαθέξεη παξαπάλσ ζε άξζξα κε Modules θαη παηάκε Save & Close. Αθνινύζσο 

θάλνπκε εηζαγσγή ηνπ Module ζηε ζέζε πνπ δεκηνπξγήζακε ζην άξζξν θαη 

ξπζκίδνπκε ην Module όπσο αθξηβώο θάλακε γηα  ηελ ξύζκηζή ηνπ ζην ππνκελνύ 

ΒΙΛΑ κε ηε δηαθνξά όηη αιιάδνπκε ηνλ ηίηιν ζε Κάληε θξάηεζε γηα ηηο king ζνπίηεο 

καο, ην Target Itemid ζε KING ΢ΟΤΙΣΑ, Position reservation-king θαη ζην Menu 

Assignment ζην Menu Selection θάλνπκε check ζην ζηνηρείν Μελνύ KING ΢ΟΤΙΣΑ. 

4.8.4.   Πξνζζήθε ζηνηρείνπ κελνύ ΣΟΠΟΘΔ΢ΙΑ 
 

Σώξα ζα δεκηνπξγήζνπκε έλα ζηνηρείν κελνύ γηα λα κπνξνύλ νη πειάηεο καο 

λα γλσξίδνπλ πνπ βξηζθόκαζηε.  

Θα δεκηνπξγήζνπκε κία θαηεγνξία κε όλνκα Σνπνζεζία όπσο έρνπκε 

αλαθέξεη πνιιέο θνξέο θαη έλα άξζξν κε όλνκα Διάηε λα καο επηζθεθζείηε. Από ην 
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δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Menus > Main Menu > Add New Menu Item 

θαη θηηάρλνπκε έλα ζηνηρείν κελνύ κε όλνκα ΣΟΠΟΘΔ΢ΙΑ. Κάησ από ην ζηνηρείν 

Μελνύ ΣΟΠΟΘΔ΢ΙΑ ζα δεκηνπξγήζνπκε δύν Τπνκελνύ, έλα κε όλνκα ΥΑΡΣΗ΢ 

θαη έλα κε όλνκα ΠΩ΢ ΝΑ ΔΡΘΔΣΔ. 

4.8.4.1.   Τπνκελνύ ΥΑΡΣΗ΢ 
 

Όιεο νη επαγγεικαηηθέο ηζηνζειίδεο δηαζέηνπλ απαξαίηεηα έλα ράξηε πνπ λα 

εκθαλίδεη ηελ ζέζε ζηελ νπνία βξίζθεηαη ε ιεηηνπξγία πνπ πεξηγξάθεη ε ηζηνζειίδα 

πάλσ ζην ράξηε. Δπηπρώο ππάξρνπλ πνιιά Μodules θαη κάιηζηα κεξηθά ειεύζεξα 

πνπ κπνξνύλ λα δείμνπλ κία ζέζε ζην ράξηε πνπ ζέινπκε λα επηιέμνπκε. 

Δκείο θαηεβάζακε ην Μodule BT Google Maps από ηελ ηζηνζειίδα 

bowthemes.com/showcase/joomla-extensions.html (12), όπσο θαίλεηαη ζηελ εηθόλα 

51. 

 

Εικόνα 51  Bοwthemes.com 

 θαη επηιέμακε ζε απηήλ ηελ εηθόλα Download ζην Module BT Google Maps όπσο 

δείρλεη ε εηθόλα 52. 
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Εικόνα 52  Εφρεςη και λήψη του Module BT Google Maps 

Αθνύ θαηέβεη ην Module ζηηο ιήςεηο ην εγθαζηζηνύκε ζηα Module ηνπ 

δηαρεηξηζηηθνύ ηνπ Joomla κε ηνλ ηξόπν πνπ εγθαηαζηήζακε θαη άιια Modules. 

Αθνινύζσο πξνβαίλνπκε ζηηο απαξαίηεηεο ξπζκίζεηο ηνπ Module ώζηε λα δείρλεη ν 

ράξηεο ηελ δηεύζπλζε ηνπ μελνδνρείνπ καο. 

Από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Extensions > Modules θαη 

πιεθηξνινγνύκε ζην πεδίν αλαδήηεζεο BT Google Maps γηα λα καο εκθαλίζεη ην 

Module πνπ ζα ξπζκίζνπκε. Αθνύ ην επηιέμνπκε εκθαλίδεηαη ην παξάζπξν ηεο 

εηθόλαο 53 ην νπνίν εκθαλίδνπκε ζε ηξία κέξε, ιόγσ αδπλακίαο εκθάληζεο ζε κία 

ζειίδα όπσο θαίλεηαη ζηηο εηθόλεο 53.1, 53.2, 53.3: 

 

Εικόνα 53.1  Ρφθμιςη του Module ΒΣ Google Maps 
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Εικόνα 53.2  Ρφθμιςη του Module ΒΣ Google Maps 

 

Εικόνα 53.3  Ρφθμιςη του Module ΒΣ Google Maps 

΢ην πεδίν Title * βάδνπκε BT Google Maps, ζην πεδίν Show Title επηιέγνπκε 

Hide, ζην πεδίν Position επηιέγνπκε gmaps, ζέζε πνπ έρνπκε δεκηνπξγήζεη κέζα ζην 

άξζξν πνπ ζα ηνπνζεηεζεί ν ράξηεο (δελ ρξεηάδεηαη λα ππελζπκίζνπκε πσο 

δεκηνπξγήζακε ην άξζξν θαη ηε ζέζε κέζα ζε απηό, αθνύ θαηά θόξνλ έρεη 

επαλαιεθζεί), ζην πεδίν Status επηιέγνπκε Published, ζην πεδίν Map Address 

βάδνπκε ηελ δηεύζπλζε ηνπ μελνδνρείνπ καο ε νπνία είλαη Κσλζηαληηλνππόιεσο 10, 

Πεξηζηέξη Αζήλα, ζηα πεδία Width, Height θαη Zoom  βάιακε Auto, 350, 13 
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αληίζηνηρα, ηα ππόινηπα πεδία ηα αθήζακε σο έρνπλ ελώ γηα ην πεδίν Google Map 

API Key δεκηνπξγνύκε έλα θιεηδί πνπ είλαη απαξαίηεην γηα λα ελεξγνπνηεζεί ην 

Module. Σν θιεηδί δεκηνπξγείηε εύθνια κέζσ ησλ νδεγηώλ πνπ δίλνληαη θάλνληαο 

click πάλσ πεδίν Google Map API Key. 

΢ηελ επηινγή Menu Assignment ζην πεδίν Module Assignment επηιέγνπκε On all 

pages except those selected θαη ζηελ επηινγή Menu Selection απελεξγνπνηνύκε ην ζηνηρείν 

κελνύ ΥΑΡΣΗ΢.  

΢ηελ επηινγή Marker Manager Add Marker εκθαλίδεηαη ε εηθόλα 54 ζηελ νπνία 

ζπκπιεξώλνπκε όλνκα, δηεύζπλζε θαη έλα θείκελν γηα ην μελνδνρείν. 

 

Εικόνα 54  Ειςαγωγή των ςτοιχείων του ξενοδοχείου μασ 

΢ηελ επηινγή Title Marker πιεθηξνινγνύκε Ξελνδνρείν ΢ηαπξάθεο, ζην 

πεδίν Marker Address πιεθηξνινγνύκε ηελ δηεύζπλζή καο Κσλζηαληηλνππόιεσο 10, 

Πεξηζηέξη  Αζήλα, ζην παξάζπξν Info Window πιεθηξνινγνύκε Σν θαιύηεξν 

μελνδνρείν ηεο πόιεο, παηάκε Update Marker θαη ηειηθά Save & Close. 

Κάλνληαο αλαλέσζε ζηελ ζειίδα καο παξαηεξνύκε όηη ν ράξηεο έρεη 

ηνπνζεηεζεί ζηελ ζέζε πνπ πεξηγξάςακε όπσο δείρλεη ε εηθόλα 55 θαη δείρλεη ηελ 

αθξηβή ζέζε ηνπ μελνδνρείνπ καο κε θόθθηλε θνπθίδα. 
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Εικόνα 55  Ο χάρτησ με την θζςη του ξενοδοχείου μασ 

4.8.4.2.   Τπνκελνύ ΠΩ΢ ΝΑ ΔΡΘΔΣΔ 
 

΢ην ππνκελνύ απηό απιώο δεκηνπξγήζακε έλα άξζξν ην νπνίν ην νλνκάζακε 

“Πώο λα έξζεηε” θαη ζην νπνίν πεξηγξάςακε όινπο ηνπο ηξόπνπο νη νπνίνη 

δηαηίζεληαη γηα ηελ πξόζβαζε ζην μελνδνρείν καο, δειαδή νδηθώο, κε ιεσθνξείν, κε 

αεξνπιάλν. 

4.8.5. Πξνζζήθε ζηνηρείνπ κελνύ ΔΠΙΚΟΙΝΩΝΙΑ 
 

Έλα ζύλεζεο ζηνηρείν κελνύ πνπ εκθαλίδεηε ζηηο ηζηνζειίδεο είλαη ε 

ΔΠΙΚΟΙΝΩΝΙΑ ην νπνίν δίλεη πιεξνθνξίεο γηα ην πσο λα επηθνηλσλνύλ νη ρξήζηεο 

κε ηελ ππεξεζία πνπ πξνζθέξεη ε ηζηνζειίδα. Δκείο δεκηνπξγήζακε έλα Component 

γηα λα ην εκθαλίζνπκε ζηελ ζειίδα επηθνηλσλία. 

Από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Component  > Contacts > 

Categories >  New δεκηνπξγνύκε κία θαηεγνξία κε όλνκα Δπηθνηλσληα θαη παηάκε 

Save & Close. Αθνινύζσο ζην Contacts: Categories επηιέγνπκε Contacts, επηιέγνπκε 

New γηα ηελ δεκηνπξγία επαθήο. Δκθαλίδεηαη ε παξαθάησ ζειίδα ηελ νπνία 

εκθαλίδνπκε ζε δύν θνκκάηηα εηθόλα 56.1, εηθόλα 56.2. 
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Εικόνα 56.1  Δημιουργία του Component επαφή και ςυμπλήρωςη οριςμζνων ςτοιχείων 

 

 

 

Εικόνα 56.2  Δημιουργία του Component επαφή και ςυμπλήρωςη οριςμζνων ςτοιχείων 

΢ην πεδίν Name * πιεθηξνινγνύκε ΢ηαύξνο Μπαιηνύζθαο, ΢πκπιεξώλνπκε 

ηα πεδία Position, Email, Address, City or Suburb, State or Province, Postal/ZIP 

Code, Country, Telephone, Mobile, Fax, ζην πεδίν Category επηιέγνπκε ηελ 

Δπηθνηλσληα θαη παηάκε Save & Close. 
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Αθνινύζσο δεκηνπξγνύκε ην ζηνηρείν Μελνύ ΔΠΙΚΟΙΝΩΝΙΑ. Από ην 

δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Menus > Main Menu > Add New Menu Item. 

΢ην πεδίν Menu Item Type * επηιέγνπκε Select >  Contacts * >  Single Contact, ζην 

πεδίν Select Contact *  επηιέγνπκε ηελ επαθή ΢ηαύξνο Μπαιηνύζθαο, ζηελ επηινγή 

Contact Display Options ξπζκίδνπκε ην πεδίν Display Format λα είλαη Plain θαη 

παηάκε Save  & Close. 

Αλ όια έρνπλ πάεη ζσζηά εκθαλίδεηαη ε εηθόλα 57 πνπ ηελ εκθαλίδνπκε ζε 

δύν κέξε εηθόλα 57.1, εηθόλα 57.2 . 

 

Εικόνα 57.2  Εμφάνιςη του Component επαφή ςτην κεντρική ςελίδα 
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4.9.   Articles - Categories Module 

Δπεηδή ζέιακε ζηελ ηζηνζειίδα καο λα δίλεηαη ε δπλαηόηεηα ζηνπο πειάηεο 

καο λα ππνβάινπλ εξσηήζεηο δηαδηθηπαθά γηα νπνηαδήπνηε απνξία ηνπο θαη λα 

παίξλνπλ απαληήζεηο θαζώο θαη λα ελεκεξώλνληαη γηα ηνπο όξνπο ρξήζεο ηεο 

κνλάδαο καο θαηαζθεπάζακε έλα Module πνπ λα εθπιεξώλεη απηό ην ζηόρν. 

Από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Content > Categories > Add 

New Category θαη δεκηνπξγνύκε κία θαηεγνξία κε όλνκα Γνλέαο θαηεγνξία όπσο 

έρνπκε πξναλαθέξεη γηα ηελ δεκηνπξγία κηαο θαηλνύξγηαο θαηεγνξίαο. ΢ηελ ζπλέρεηα 

δεκηνπξγνύκε δύν θαηεγνξίεο κε νλόκαηα ΢πρλέο Δξσηήζεηο θαη Όξνη ρξήζεο 

αληίζηνηρα θαη ζηελ επηινγή Parent δίλνπκε ηελ θαηεγνξία Γνλέαο θαηεγνξία. Έπεηηα 

δεκηνπξγνύκε δύν άξζξα κε νλόκαηα ΢πρλέο Δξσηήζεηο θαη Όξνη ρξήζεο θαη ηα 

εληάζζνπκε ζηηο θαηεγνξίεο ΢πρλέο Δξσηήζεηο θαη Όξνη ρξήζεο αληίζηνηρα. 

Καηόπηλ δεκηνπξγνύκε ην Μodule Articles-Categories ην νπνίν καο εκθαλίδεη 

ηα δύν άξζξα πνπ θηηάμακε. Από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Extensions 

> Modules > New > Articles – Categories θαη καο εκθαλίδεηαη ε εηθόλα 58. 

 

Εικόνα 58  Δημιουργία και ρφθμιςη του Articles-Categories Module 

΢ην πεδίν Title * πιεθηξνινγνύκε parent_category, ζην πεδίν Show Title 

επηιέγνπκε ην Hide, ζηελ επηινγή Position δίλνπκε ηελ ζέζε footer1, ζηελ επηινγή  

Parent Category επηιέγνπκε ηελ θαηεγνξία Γνλέαο θαηεγνξία, ζην Menu Assignment 

ζην Module Assignment επηιέγνπκε Only the pages selected, ζην Menu Selection  

επηιέγνπκε όια ηα ζηνηρεία κελνύ, εθηόο από ηα ζηνηρεία κελνύ ΑΡΥΙΚΗ θαη 

ΔΠΙΚΟΙΝΩΝΙΑ θαη παηάκε Save & Close. Παξαηεξνύκε θάλνληαο αλαλέσζε όηη 
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ζην θάησ κέξνο ησλ επηιεγκέλσλ ζειίδσλ εκθαλίδνληαη ηα άξζξα ηνπ Module πνπ 

δεκηνπξγήζακε, όπσο θαίλνληαη ζηελ εηθόλα 59. 

 

Εικόνα 59  Εμφάνιςη του Articles – Categories Module ςτην κεντρική ςελίδα 
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ΚΔΦΑΛΑΙΟ 5 

5.1.   Γεκηνπξγία πνιπγιωζζηθήο ηζηνζειίδαο. 
 

       Μέρξη ζηηγκήο έρνπκε δεκηνπξγήζεη ηελ ηζηνζειίδα καο, αιιά εκθαλίδεηαη κόλν 

ζηελ ειιεληθή γιώζζα, απηό όκσο δελ είλαη αξθεηό, γηαηί νη επηζθέπηεο πνπ ζα έρνπλ 

πξόζβαζε ζηελ ζειίδα καο δελ ζα είλαη κόλν έιιελεο, αιιά θπξίσο ζα είλαη μέλνη 

από δηάθνξεο ρώξεο ηνπ πιαλήηε. Δίλαη αλαγθαίν ινηπόλ ε ηζηνζειίδα καο λα είλαη 

πνιπγισζζηθή. Δκείο εκθαλίζακε ηελ ηζηνζειίδα καο ζε δύν γιώζζεο ηελ Διιεληθή 

θαη ηελ Αγγιηθή κηαο θαη ε Αγγιηθή είλαη δηεζλήο γιώζζα. Βέβαηα κε ηνλ ίδην ηξόπν 

κπνξνύκε λα εκθαλίδνπκε ηελ ηζηνζειίδα καο ζε όζεο γιώζζεο επηιέμνπκε. 

        Παξαθάησ εμεγνύκε ηα βήκαηα πνπ θάλακε, πξνθεηκέλνπ λα δείμνπκε πσο 

θάλακε ηελ ηζηνζειίδα καο πνιπγισζζηθή. 

5.1.1.   Δλεξγνπνίεζε System-Language-Filter θαη System-Language-Code 

Σν πξώην βήκα πνπ θάλακε ήηαλ λα ελεξγνπνηήζνπκε δύν Plugins. Από ην 

δηαρεηξηζηηθό ηνπ Joomla επηιέγακε Extensions -> Plugins θαη ζην πεδίν Search 

γξάςακε Lang θαη παηήζακε enter.  

Θα καο εκθαλίζεη δύν Plugins, System-Language Filter θαη System-Language 

Code. Δπεηδή απηά ηα δύν Plugins ζην Joomla είλαη απελεξγνπνηεκέλα εκείο ηα 

ελεξγνπνηνύκε όπσο δείρλεη ε εηθόλα 60. 

 

Εικόνα 60  Ενεργοποίηςη System-Language Filter και System-Language Code 
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5.1.2.   Γεκηνπξγία ειιεληθνύ πεξηερνκέλνπ γιώζζαο  

Γηα λα εγθαηαζηήζνπκε ην πεξηερόκελν ηεο ειιεληθήο γιώζζαο κεηαβήθακε 

ζην δηαρεηξηζηηθό ηνπ Joomla θαη επηιέμακε: Extensions > Language(s) >   Content 

Languages, επηιέγνπκε New θαη ζα εκθαληζηεί ε εηθόλα 61. 

 

 

Εικόνα 61  Δημιουργία ελληνικοφ περιεχομζνου γλϊςςασ 

΢ην πεδίν Title * πιεθηξνινγήζακε Greek, ζην πεδίν Title Native * 

πιεθηξνινγήζακε Διιεληθά, ζην πεδίν Language Tag * βάιακε el-GR, ζην πεδίν 

URL Language Code * επηιέμακε el, ζην Image Prefix επηιέμακε el θαη ηέινο 

παηήζακε Save & Close. 

• Γεκηνπξγία  Language Switcher Module 

       Αθνινύζσο πξέπεη λα δεκηνπξγήζνπκε έλα Module ην νπνίν είλαη ρξήζηκν 

γηα ηελ ηνπνζέηεζε ησλ ζεκαηώλ ζην Template θαη κε έλα click λα κεηαβαίλνπκε 

από ηελ κία γιώζζα ζηελ άιιε. Οπόηε ζα πάκε ζηα Modules  θαη επηιέγνπκε New 

θαη ν ηύπνο ηνπ Module πνπ ζα επηιέμνπκε ζα είλαη Language Switcher όπσο 

θαίλεηαη ζηελ εηθόλα 62. 
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Εικόνα 62  Δημιουργία Module  Language Switcher 

 Θα ηνπ δώζνπκε έλα όλνκα Language Switcher θαη δελ ζα εκθαλίζνπκε ηνλ ηίηιν 

ηνπ, ζα ηνπ δώζνπκε ζην Position ηελ ζέζε top2, ζα ην εκθαλίζνπκε ζε όιεο ηηο 

ζειίδεο θαη κεηά ζα παηήζνπκε Save & Close. Αλ πάκε ζηελ θεληξηθή ζειίδα δελ 

ζα εκθαληζηεί, γηαηί δελ έρνπκε δεκηνπξγήζεη ηα αγγιηθά (κεηαθξαζκέλα) κελνύ.  

• Γεκηνπξγία πνιπγιωζζηθώλ κελνύ   

     ΢ηελ πεξηνρή δηαρείξηζεο ηνπ Joomla γηα ηελ δεκηνπξγία πνιπγισζζηθνύ Μελνύ 

επηιέγνπκε Menus > Manage θαη New θαη ζα δεκηνπξγήζνπκε δύν λέα Μελνύ, έλα 

Main Menu EN θαη έλα Main Menu GR (αγγιηθό θαη ειιεληθό αληίζηνηρα). ΢ηελ 

ζπλέρεηα ζα πξέπεη λα αληηγξάςνπκε όια ηα ζηνηρεία κελνύ ηνπ Main Menu ζηα 

άιια δύν. Από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Menus > Main Menu θαη ζα 

ελεξγνπνηήζνπκε ην θνπκπί (Check All) αξηζηεξά από ην θνπκπί Status γηα λα 

επηιεγνύλ όια ηα ζηνηρεία ηνπ Μελνύ. Αθνινύζσο επηιέγνπκε Batch θαη όπσο δείρλεη 

ε εηθόλα 63. 
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Εικόνα 63  Αντιγραφή των ςτοιχείων μενοφ το Main Menu ςτο Main Menu EN 

 ζηελ επηινγή To Move or Copy your selection please select a Menu or parent item.   

θάλνπκε click ζην Add to this menu ζην Main Menu EN, ελεξγνπνίεζε ηνπ Copy θαη 

κεηά click ζην Process. 

Σν ίδην αθξηβώο ζα θάλνπκε θαη γηα ηελ αληηγξαθή ησλ ζηνηρείσλ Μελνύ από 

ην Main Menu ζην Main Menu GR.  

Αθνύ ινηπόλ γίλεη απηό ζα πξέπεη λα κεηαθξάζνπκε ηα ζηνηρεία ηνπ Main 

Menu EN θαη Main Menu GR ζηελ αληίζηνηρε γιώζζα ηνπ θαζελόο, νπόηε ζα πάκε 

ζην Main Menu EN θαη ζα ηα επηιέμνπκε όια ηα ζηνηρεία ηνπ ζα θάλνπκε click ζην 

θνπκπί Batch θαη ζην Set Language επηιέγνπκε ηελ επηινγή English θαη ζα θάλνπκε 

click ζην Process. 

Σν ίδην αθξηβώο ζα θάλνπκε θαη γηα ην Main Menu GR κε ηη δηαθνξά όηη ζην 

Set Language ζα επηιέμνπκε ηελ επηινγή Greek. 

  Έπεηηα ζην Main Menu EN θαη ζην Main Menu GR ζα βάινπκε σο Default 

page ην πξώην ζηνηρείν από θάζε Μελνύ (όπσο εκθαλίζηεθαλ κεηά ηελ αληηγξαθή), 

δειαδή ην ζηνηρείν Μελνύ ΑΡΥΙΚΗ (2) ηνπ Main Menu EN θαη ην ζηνηρείν 

ΑΡΥΙΚΗ (3) ηνπ Main Menu GR. Έπεηηα ζα πξέπεη λα δηαγξάςνπκε όια ηα ζηνηρεία 

ηνπ Main Menu εθηόο από έλα, αιιά δελ κπνξνύκε λα ην ζβήζνπκε. Οπόηε 

δηαηεξνύκε ζε απηό κόλν ην ζηνηρείν Μελνύ ΑΡΥΙΚΗ. 

  Μεηά ζα πάκε ζην Main Menu EN γηα λα θαη ζα κεηνλνκάζνπκε όια ηα 

ζηνηρεία ηνπ ζηα αγγιηθά: 
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• Menu Title ΑΡΥΙΚΗ(2) ζε ΗΟΜΔ 

• Menu Title * ΠΑΡΟΥΔ΢ (2) ζε PROVISIONS 

• Menu Title * ΦΩΣΟΓΡΑΦΙΔ΢ (2)  ζε PHOTOGRAPHS 

• Menu Title * ΠΔΡΙΟΥΗ΢ (2) ζε AREA PHOTOS 

• Menu Title ΞΔΝΟΓΟΥΙΟΤ (2)  ζε HOTEL PHOTOS 

• Menu Title * ΓΩΜΑΣΙΩΝ  (2) ζε ROOMS PHOTOS 

• Menu Title * ΚΡΑΣΗ΢ΔΙ΢ (2)  ζε REZERVATIONS 

• Menu Title * ΒΙΛΑ (2)  ζε THE VILLA 

• Menu Title * ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ (2) ζε DELUXE SUITE 

• Menu Title * KING ΢ΟΤΙΣΑ (2)  ζε KING SUITE 

• Menu Title * ΣΟΠΟΘΔ΢ΙΑ (2)  ζε LOCATION 

• Menu Title * ΥΑΡΣΗ΢ (2)  ζε MAP 

• Menu Title * ΠΩ΢ ΝΑ ΔΡΘΔΣΔ (2)  ζε HOW TO COME 

• Menu Title * ΔΠΙΚΟΙΝΩΝΙΑ (2)  ζε CONTACT US 

Σν ίδην ζα θάλνπκε θαη ζην Main Menu GR: 

• Menu Title * ΑΡΥΙΚΗ (3) ζε ΑΡΥΙΚΗ 

• Menu Title * ΠΑΡΟΥΔ΢ (3) ζε ΠΑΡΟΥΔ΢ 

• Menu Title * ΦΩΣΟΓΡΑΦΙΔ΢ (3) ζε ΦΩΣΟΓΡΑΦΙΔ΢ 

• Menu Title * ΠΔΡΙΟΥΗ΢ (3) ζε ΠΔΡΙΟΥΗ΢ 

• Menu Title * ΞΔΝΟΓΟΥΔΙΟΤ (3) ζε ΞΔΝΟΓΟΥΔΙΟΤ 

• Menu Title * ΓΩΜΑΣΙΩΝ (3) ζε ΞΔΝΟΓΟΥΔΙΟΤ 

• Menu Title * ΚΡΑΣΗ΢ΔΙ΢ (3) ζε ΚΡΑΣΗ΢ΔΙ΢ 

• Menu Title * ΒΙΛΑ (3) ζε ΒΙΛΑ 
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• Menu Title * ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ (3) ζε ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ 

• Menu Title * ΚΙNG ΢ΟΤΙΣΑ (3) ζε KING ΢ΟΤΙΣΑ  

• Menu Title * ΣΟΠΟΘΔ΢ΙΑ (3) ζε ΣΟΠΟΘΔ΢ΙΑ 

• Menu Title * ΥΑΡΣΗ΢ (3) ζε ΥΑΡΣΗ΢ 

• Menu Title * ΠΩ΢ ΝΑ ΔΡΘΔΣΔ (3) ζε ΠΩ΢ ΝΑ ΔΡΘΔΣΔ 

• Menu Title * ΔΠΙΚΟΙΝΩΝΙΑ (3) ζε ΔΠΙΚΟΙΝΩΝΙΑ 

Αθνύ ινηπόλ γίλεη θαη απηό ην βήκα, ζα πξέπεη λα εκθαλίζνπκε θαη ηα Modules ζηηο 

αληίζηνηρεο γιώζζεο. Πάκε ινηπόλ ζηα Modules θάλνπκε Check All ζηo θνπκπί 

αξηζηεξά ηνπ Status παηάκε ζην button Batch θαη  ζην Set Language ζα επηιέμνπκε 

Greek θαη παηάκε Process. 

      Σώξα ζα πξέπεη λα αληηγξάςνπκε ηα Modules γηα λα εκθαληζηνύλ θαη ζηα 

αγγιηθά. Δπηιέγνπκε ινηπόλ πάιη όια ηα Modules παηάκε πάιη ην θνπκπί Batch. ΢ην 

Set Language επηιέγνπκε ηε γιώζζα λα είλαη English, ζην Set Position επηιέγνπκε 

Keep original Position, γηα λα δηαηεξεζνύλ νη ίδηεο ζέζεηο κεηά click ζην θνπκπάθη 

Copy θαη click ζην Process. 

      Παξαηεξνύκε όηη ηα αληίγξαθά καο είλαη απελεξγνπνηεκέλα θαη ζα πξέπεη λα ηα 

ελεξγνπνηήζνπκε. Οπόηε ζα επηιέμνπκε κόλν ηα αγγιηθά δειαδή ηα αληίγξαθα θαη ζα 

θάλνπκε click ζην θνπκπί πνπ ιέεη Publish. 

Δπεηδή ινηπόλ ζηελ ζειίδα καο πξέπεη λα εκθαλίδνληαη αλάινγα κε ηελ 

γιώζζα ηα Μελνύ πνπ δεκηνπξγήζακε ηα θαζηζηνύκε Main Menu σο εμήο: 

Πιεθηξνινγνύκε ζηελ αλαδήηεζε Main Menu επηιέγνπκε ην Main Menu θαη 

ζην Select Menu επηιέγνπκε ην Main Menu GR θαη παηάκε Save & Close. 

Κάλνπκε click ζην Main Menu (2) (δειαδή ζην αληίγξαθν, ζην αγγιηθό) θαη 

ζην Select Menu ζα επηιέμνπκε ην Main Menu EN θαη παηάκε Save & Close. 

Γηα ηελ εκθάληζε ησλ δηαθνξεηηθώλ Μελνύ πξέπεη λα έρνπκε θαη δύν 

Templates ζηηο δύν γιώζζεο. 

Η δηαδηθαζία κε ηελ νπνία δεκηνπξγνύκε αληίγξαθα ελόο Template γίλεηε σο εμήο: 
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Από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Extensions > Templates > Styles θαη 

επηιέγνπκε ην Template καο θαη επηιέγνπκε Duplicate δύν θνξέο. Παξαηεξνύκε όηη 

εκθαλίζηεθαλ άιια δύν αληίγξαθα από ην Template καο. 

 Γηαιέγνπκε έλα από απηά, ην κεηνλνκάδνπκε όπσο δείρλεη ε εηθόλα 64 

 

Εικόνα 64  Μετονομαςία αντιγράφου Template ςε shaper_helix3 - GR 

ζε shaper_helix3 – GR θαη ζην πεδίν Default ζα επηιέμνπκε Greek, ζηελ επηινγή 

Menu ζην πεδίν Select Menu επηιέγνπκε Main Menu GR, ζην πεδίν Menu Type ζα 

επηιέμνπκε ην Mega Menu, ζηελ επηινγή Basic ζπκπιεξώζακε ηα πεδία Phone θαη 

Email θαη ζηελ επηινγή Assignment θάλακε check κέζσ ηνπ Toggle Selection κόλν 

ζηα ζηνηρεία Μελνύ ηνπ Main Menu GR όπσο δείρλεη ε εηθόλα 65 θαη παηάκε Save & 

Close. 

 

Εικόνα 65  Επιλογή των ςτοιχείων μενοφ του Main Menu GR του Template shaper_helix3 _ GR 
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     Αθξηβώο ην ίδην ζα θάλνπκε θαη ζην αγγιηθό Template απιά δελ ζα βάινπκε ηα 

ίδηα πνπ βάιακε ζην ειιεληθό, αιιά ζην Style * Name ζα πιεθηξνινγήζνπκε 

shaper_helix3 – EN, ζην Default ζα επηιέμνπκε English. Έπεηηα ζα πάκε ζηελ 

επηινγή Menu, ζα επηιέμνπκε ζην Select Menu ην Μελνύ Main Menu EN θαη ζηελ 

επηινγή Assignment ζα ηζεθάξνπκε όια ηα ζηνηρεία Μελνύ ηνπ, έηζη ώζηε λα 

εκθαλίδεη κόλν ηα ζηνηρεία ηνπ αγγιηθνύ Μελνύ όπσο δείρλεη ε εηθόλα 66 θαη ζα 

 

Εικόνα 66 Επιλογή των ςτοιχείων μενοφ του Main Menu EN του Template shaper_helix3 - EN 

 παηήζνπκε  Save & Close. 

• Μεηάθξαζε άξζξωλ θαη ζύλδεζε ζηνηρείωλ κελνύ κεηαμύ ηνπο 

    Μεηαθξάζακε όια ηα άξζξα ηεο ζειίδαο καο θαη μεθηλήζακε θπζηθά από ηα ηξία 

άξζξα ηηο αξρηθήο ζειίδαο καο (Βίια, King ζνπίηα, Πνιπηειήο ζνπίηα). Από ην 

δηαρεηξηζηηθό ηνπ Joomla επηιέμακε Content -> Categories θαη ζην πεδίν Search 

πιεθηξνινγήζακε Αξρηθή γηα ζύληνκε εύξεζε ηεο θαηεγνξίαο Αξρηθή. Δπηιέμακε 

ηελ θαηεγνξία απηή θαη ζηελ επηινγή Language επηιέμακε Greek όπσο δείρλεη ε 

εηθόλα 67 θαη παηάκε Save & Close. 
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Εικόνα 67  Επιλογή τησ κατηγορίασ Αρχική και επιλογή τησ κυλιόμενησ μπάρασ Language ςε Greek 

Γηα λα γίλεη έλα αληίγξαθν ηεο θαηεγνξίαο απηήο γηα ηελ αγγιηθή γιώζζα από 

ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε ηελ θαηεγνξία Αξρηθή παηάκε ην θνπκπί 

Batch θαη ζηελ επηινγή Set Language ζα επηιέμνπκε English, ζηελ επηινγή To Move 

or Copy your selection please select a Category επηιέγνπκε Add to root, αθνινύζσο 

Copy θαη παηάκε Process  όπσο δείρλεη ε εηθόλα 68. 

 

Εικόνα 68  Δημιουργία αντιγράφου τησ κατηγορίασ Αρχική με όνομα Home 

 ΢ηε ζπλέρεηα ελεξγνπνηνύκε ηελ λέα θαηεγνξία αληίγξαθo θαη ζα ηελ νλνκάζνπκε 

Home. 

  Γηα λα εκθαληζηνύλ ηα άξζξα καο (Βίια, King ζνπίηα θαη Πνιπηειήο ζνπίηα) 

θάησ από ηελ θαηεγνξία Home κεηαθξαζκέλα ζηα αγγιηθά αθνινπζνύκε ηελ εμήο 
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δηαδηθαζία. Δπηιέγνπκε πξώηα ην άξζξν Βίια από Articles, πεγαίλνπκε ζην Batch 

θαη ζηελ επηινγή Set Language ζα επηιέμνπκε English, ζηελ επηινγή To Move or 

Copy your selection please select a Category ζα επηιέμνπκε Home, ζα θάλνπκε click  

ζηελ επηινγή Copy θαη ζα παηήζνπκε Process όπσο δείρλεη ε εηθόλα 69. 

 

Εικόνα 69  Δημιουργία αντιγράφου του άρθρου Βίλα με όνομα The vila 

΢ηελ νπζία θάλακε έλα αληίγξαθν ηνπ άξζξνπ Βίια ην νπνίν ελ ζπλερεία ζα 

ην ελεξγνπνηήζνπκε θαη ζα πξέπεη λα ην κεηαθξάζνπκε ζηα αγγιηθά. Θα ην 

νλνκάζνπκε The vila ζα ηνπ αιιάμνπκε θαη ην πεξηερόκελν από ειιεληθά ζηα 

αγγιηθά, ζα πάκε ζηελ επηινγή Options θαη ζην πεδίν Read More Text γξάθνπκε 

Read More  θαη ζα παηήζνπκε Save & Close. 

  Η ίδηα δηαδηθαζία ζα γίλεη θαη ζηα άιια δύν άξζξα, ζα αληηγξάςνπκε ηα 

άξζξα καο, δίλνληαο ηνπο ηελ γιώζζα English θαη ηελ θαηεγνξία Home. Θα ηνπο 

αιιάμνπκε όλνκα ζε   King suite θαη Deluxe suite αληίζηνηρα, ζα ηνπο αιιάμνπκε ην 

πεξηερόκελν ηνπο από ηα ειιεληθά ζηα αγγιηθά ζηελ επηινγή Options ζην πεδίν Read 

More Text ζα ηνπο εηζάγνπκε ηελ πξόηαζε Read More θαη ζα παηήζνπκε Save & 

Close. 

  Από ην δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Menus > Main Menu EN 

θάλνπκε click ζην ζηνηρείν κελνύ HOME θαη αθνινπζνύκε ηελ ίδηα δηαδηθαζία πνπ 

θάλακε θαη κε ην ειιεληθό ζηνηρείν Μελνύ ηελ ΑΡΥΙΚΗ. Γειαδή ζην Menu Item 

Type * ζα επηιέμνπκε ην Category Blog θαη ζην Choose a Category * ζα επηιέμνπκε 

ηελ θαηεγνξία Home. ΢ηελ επηινγή Blog Layout ζηα πεδία Leading Articles, Intro 

Articles θαη Columns ζα εηζάγνπκε ηηο ηηκέο 0, 3, 3 αληίζηνηρα όπσο δείρλεη ε  εηθόλα 

70:  
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Εικόνα 70  Ρυθμίςεισ πεδίων ςτο Blog Layout  

  ΢ηελ επηινγή Associations ηεο παξαπάλσ εηθόλαο ζα επηιέμνπκε από ηελ 

θπιηόκελε κπάξα ηελ ΑΡΥΙΚΗ(el-GR) όπσο δείρλεη ε παξαθάησ εηθόλα 71. 

 

Εικόνα 71 ΢φνδεςη του Αγγλικοφ ςτοιχείου μενοφ με το ελληνικό ςτοιχείο μενοφ 

Ο ιόγνο πνπ γίλεηε ε παξαπάλσ επηινγή είλαη λα ζπλδεζεί ην αγγιηθό ζηνηρείν 

Μελνύ ΗOME κε ην ειιεληθό ζηνηρείν Μελνύ ΑΡΥΙΚΗ θαη παηάκε Save & Close.  

Σελ ίδηα δηαδηθαζία ζα αθνινπζήζνπκε γηα όιεο ηηο θαηεγνξίεο θαη γηα όια ηα 

άξζξα. Γειαδή ζα επηιέγνπκε κία θαηεγνξία ζα ηελ κεηαηξέπνπκε ζε Greek, ζα 

θάλνπκε αληίγξαθό ηεο θαη ζα ηελ κεηαηξέπνπκε ζε English, ζα ηελ ελεξγνπνηνύκε  

γηαηί είλαη απελεξγνπνηεκέλε, ζα αληηγξάθνπκε ηα άξζξα καο, ζα ηνπο δίλνπκε ηελ 

αγγιηθή γιώζζα θαη θαηεγνξία, ζα επηιέγνπκε ην θάζε αγγιηθό ζηνηρείν Μελνύ λα 

ζπλδέεηαη κε ην ειιεληθό. Η αληηζηνίρεζε ζα είλαη ε παξαθάησ. 
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• HOME (en-GB) > ΑΡΥΙΚΗ (el-GR) 

• PROVISIONS (en-GB) > ΠΑΡΟΥΔ΢ (el-GR) 

• PHOTOGRAPHS (en-GB) > ΦΩΣΟΓΡΑΦΙΔ΢ (el-GR) 

• AREA PHOTOS (en-GB) > ΠΔΡΙΟΥΗ΢ (el-GR) 

• HOTEL PHOTOS (en-GB) > ΞΔΝΟΓΟΥΔΙΟΤ (el-GR) 

• ROOMS PHOTOS (en-GB) > ΓΩΜΑΣΙΟΤ (el-GR) 

• RESERVATIONS (en-GB) > ΚΡΑΣΗ΢ΔΙ΢ (el-GR) 

• THE VILA (en-GB) > ΒΙΛΑ (el-GR) 

• DELUXE SUITE (en-GB) > ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ (el-GR) 

• KING SUITE (en-GB) > ΠΟΛΤΣΔΛΗ΢ ΢ΟΤΙΣΑ (el-GR) 

• LOCATION (en-GB) > ΣΟΠΟΘΔ΢ΙΑ (el-GR) 

• MAP (en-GB) > ΥΑΡΣΗ΢ (el-GR) 

• HOW TO COME (en-GB) > ΠΩ΢ ΝΑ ΔΡΘΔΣΔ (el-GR) 

• CONTACT US (en-GB) > ΔΠΙΚΟΙΝΩΝΙΑ (en-GR) 
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ΚΔΦΑΛΑΙΟ 6 

6.1.   Akeeba Backup 
 

Σν Akeeba Backup είλαη έλα Component κε ην νπνίν έρνπκε ηελ δπλαηόηεηα 

λα παίξλνπκε αληίγξαθα αζθάιεηαο γηα ηελ ηζηνζειίδα καο. Σν Akeeba Backup είλαη 

δηαζέζηκν ζην δηαδίθηπν θαη κάιηζηα δσξεάλ. Δκείο ην θαηεβάζακε από ηελ 

ηζηνζειίδα ηνπ Akeeba Backup (13). 

6.2.   Δγθαηάζηαζε -Ρπζκίζεηο  
 

Αθνύ γίλεη ε ιήςε ηνπ αξρείνπ Akeeba Backup ζε κνξθή .zip από ην    

δηαρεηξηζηηθό ηνπ Joomla επηιέγνπκε Extensions > Manage > Install επηιέγνπκε ην 

αξρείν .zip θαη παηάκε Upload & Install όπσο δείρλεη ε εηθόλα 72. 

 

 
 

Εικόνα 72  Ανζβαςμα του Component Akeeba Backup ςτο περιβάλλον του Joomla 

Η επηηπρήο εγθαηάζηαζε ηνπ Akeeba Backup ζηα Components δηαπηζηώλεηε  

εύθνια επηιέγνληαο Components ζην δηαρεηξηζηηθό ηνπ Joomla. 

 

6.3.   Αληίγξαθν αζθάιεηαο κε ην Akeeba Backup 
 

Αθνύ ινηπόλ εγθαηαζηήζακε ην Akeeba Backup κεηαβαίλνπκε ζην 

πεξηβάιινλ δηαρείξηζεο (Backend) ηνπ Joomla θαη επηιέγνπκε Components > Akeeba 

Backup. Δκθαλίδεηαη ε εηθόλα 73. 
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Εικόνα 73  Akeeba Backup : Control Panel 

΢ηελ εηθόλα 73 επηιέγνπκε Backup Now. Δκθαλίδεηαη ε εηθόλα 74. 

 

Εικόνα 74  Επιλογή του κουμπιοφ Backup Now!  

Δπηιέγνπκε ην Backup Now! θαη εκθαλίδεηαη ε εηθόλα 75 ζηελ νζόλε ε νπνία 

δείρλεη ηελ πξόνδν ιήςεο ηνπ αληηγξάθνπ αζθαιείαο. 
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Εικόνα 75  Πρόοδοσ λήψησ αντιγράφου αςφάλειασ 

Σν αληίγξαθν αζθαιείαο πνπ παίξλνπκε πεξηέρεη όια ηα αξρεία, έλα 

ζηηγκηόηππν ηεο βάζεο δεδνκέλσλ θαη έλα ζελάξην απνθαηάζηαζεο. 

Αθνύ νινθιεξσζεί ε ιήςε ηνπ Akeeba Backup ην αξρείν καο βξίζθεηαη ζην 

Path  C:/wamp/www/hotel1/administrator/components/com_akeeba/backup/site-

localhost-20161222-090432.jpa. Πξνθαλώο ην site-localhost-20161222-090432.jpa 

αξρείν  κπνξνύκε λα ην δηαηεξνύκε θαη ζε άιια κέζα απνζήθεπζεο π.ρ. εμσηεξηθό 

δίζθν, USB Stick θ.ι.  

6.4. Restore από Akeeba Backup 
 

Γηα ηελ επαλάθηεζε ηεο ηζηνζειίδα καο από έλα αληίγξαθν αζθάιεηαο πνπ 

έρνπκε πάξεη κε Akeeba Backup ζε έλαλ ππνινγηζηή πνπ ππνζηεξίδεη Wamp ε 

Xampp (ζηελ πξνθεηκέλε πεξίπησζε ην Wamp) αθνινπζνύκε ηα παξαθάησ βήκαηα. 

Γεκηνπξγνύκε ζηνλ ππνινγηζηή πνπ ζέινπκε λα εγθαηαζηήζνπκε ηελ ηζηνζειίδα 

έλαλ θαηλνύξγην θάθειν ζην C:/Wamp/www κε έλα όλνκα έζησ hotel1 θαη θάλνπκε 

αληηγξαθή επηθόιιεζε ζ‟ απηόλ  ην ηειεπηαίν αληίγξαθν αζθαιείαο .jpa αξρείν πνπ 

έρνπκε πάξεη. ΢ηελ πεξίπησζή καο ην πήξακε από έλα USB Stick όπσο δείρλεη ε 

εηθόλα 76. 

 

 

Εικόνα 76  Επιλογή και αντιγραφή του αντιγράφου αςφάλειασ από ζνα USB Stick 
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΢ηνλ ίδην θάθειν θάλνπκε αληηγξαθή/επηθόιιεζε ην αξρείν kickstart-core-

5.2.1.zip ην νπνίν ην έρνπκε ζην USB Stick. Αλ δελ ην έρνπκε ζα πξέπεη λα ην 

θαηεβάζνπκε από ηελ ηζηνζειίδα Akeeba kickstart (14).  

΢ην θάθειν hotel1 ζα βξίζθνληαη ηώξα ηα δύν αξρεία πνπ αληηγξάςακε, όπσο 

δείρλεη ε εηθόλα 77.  

 

 

Εικόνα 77  Επικόλληςη του Αντιγράφου αςφάλειασ και του kickstart ςτον C:/Wamp/www/hotel1 

 

Δπεηδή ην αξρείν kickstart-core-5.2.1 είλαη .zip ην θάλνπκε Extract ζηνλ 

ηξέρνληα θάθειν θαη ην zip αξρείν κπνξνύκε λα ην δηαγξάςνπκε σο πεξηηηό.  

΢ε έλα Browser πιεθηξνινγνύκε http://localhost/hotel1/kickstart.php. Μαο 

εκθαλίδεη ηελ εηθόλα 78 ε νπνία έρεη νξηζκέλεο ξπζκίζεηο σο πξνεπηινγή. Σηο 

αθήλνπκε σο έρνπλ θαη θάλνπκε click ζην θνπκπί Start. 
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Εικόνα 78  Εμφάνιςη οριςμζνων προεπιλεγμζνων ρυθμίςεων 

 

Θα παξαηεξήζνπκε όηη αξρίδεη ηελ εγθαηάζηαζε ησλ αξρείσλ ηεο 

ηζηνζειίδαο καο, όπσο δείρλεη ε εηθόλα 79. 

 

 

Εικόνα 79  Εγκατάςταςη των αρχείων τησ ιςτοςελίδασ 

 

Αθνύ νινθιεξσζεί ε εγθαηάζηαζε ησλ αξρείσλ καο εκθαλίδεη ηελ εηθόλα 80, 

ζηελ νπνία  θάλνπκε  click ζην θνπκπί Run the Installer.  
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Εικόνα 80  Επιλογή του κουμπιοφ Run the Installer 

΢ηελ εηθόλα 81 πνπ εκθαλίδεηαη όπσο θαίλεηαη παξαθάησ αθήλνπκε ηηο 

επηινγέο σο έρνπλ θαη παηάκε Next. 

 

 

Εικόνα 82  Οριςμζνεσ επιλογζσ τισ οποίεσ τησ αφήνουμε ωσ ζχει και πατάμε Next 

Η εηθόλα 83 πνπ ζα παξαηεξήζνπκε είλαη γηα ηελ εγθαηάζηαζε ηεο βάζεο 

δεδνκέλσλ. Αθήλνπκε ηηο επηινγέο σο έρνπλ θαη παηάκε Next. 
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Εικόνα 83  Εγκατάςταςη τησ Βάςησ δεδομζνων 

Αθνύ νινθιεξσζεί ε εγθαηάζηαζε ηηο βάζεο δεδνκέλσλ, καο εκθαλίδεη ηελ 

εηθόλα 84 θαη παηάκε Next step. 

 

 

Εικόνα 84  Η Εγκατάςταςη τησ βάςησ ζγινε με επιτυχία 

 

΢ηελ επόκελε εηθόλα πνπ εκθαλίδεηε γηα ηηο παξακέηξνπο ηεο ηζηνζειίδαο δελ 

ρξεηάδεηαη λα αιιάμνπκε θάηη θαη παηάκε Next. 
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Εικόνα 85  Οριςμζνοι παράμετροι τισ ιςτοςελίδασ τησ αφήνουμε όπωσ είναι και πατάμε Next 

 

Σέινο καο εκθαλίδεηαη ε νινθιήξσζε ηηο εγθαηάζηαζεο όπσο δείρλεη ε 

εηθόλα 86 θιείλνπκε ηελ ηξέρνπζα θαξηέια, γηα λα επηζηξέςνπκε ζην kickstart θαη 

παηάκε Clean Up, όπσο δείρλνπλ νη εηθόλεο. 

 

Εικόνα 86  Ολοκλήρωςη εγκατάςταςησ 

Η εηθόλα 87 πνπ εκθαλίδεηαη είλαη γηα ηελ επηινγή ηεο εκθάληζεο ηεο 

ηζηνζειίδαο καο, ή ηεο εκθάληζε ηνπ δηαρεηξηζηηθνύ ηνπ Joomla.  
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Εικόνα 87 Μετάβαςη ςτο επιθυμητό περιβάλλον  

6.5.  Αλέβαζκα αξρείωλ ζε Web Server 

    Σν αλέβαζκα ελόο αξρείνπ ζε έλαλ Web Server κπνξνύκε λα ην θάλνπκε κε δύν 

ηξόπνπο: 

1.  Να αλεβάζνπκε ην αξρείν κέζσ ελόο  FTP Client ηνπ Server καο. Δίλαη ν πην 

απιόο θαη ζύληνκνο ηξόπνο. Δκείο αλαδεηήζακε ζην google έλαλ host Web 

Server γηα ειεύζεξε θηινμελία ηεο ηζηνζειίδαο καο. Ο Hostinger Web Server  

παξέρεη ειεύζεξε θηινμελία κέρξη 2GB. 

 
Εικόνα 88  Παραγγελία για δωρεάν η εμπορική φιλοξενία 

 

    Δπηζθεθζήθακε απηήλ ηελ ζειίδα θαη επηιέμακε ηελ πξώηε επηινγή πνπ 

είλαη δσξεάλ 0,00 € θαη θάλακε click ζην θνπκπί παξαγγειία. Μαο δεηάεη λα 

επηιέμνπκε Domain Name. Δθόζνλ είλαη δηαζέζηκν καο ζηέιλεη κήλπκα ζην 
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email καο κε ην username θαη password γηα είζνδν ζηελ ηζηνζειίδα ηνπ Web 

Server. 

    Πιεθηξνινγνύκε ζηελ κεραλή αλαδήηεζεο cpanel.hostinger.gr. 

Δκθαλίδεηαη ε εηθόλα 89. 

 

Εικόνα 89  Ειςαγωγή των ςτοιχείων  

    Δηζάγνληαο ην Password καο κεηαθέξεη ζηελ ζειίδα ηνπ Web Server. ΢ηελ 

επηινγή Αξρεία, όπσο δείρλεη ε εηθόλα 90, επηιέγνπκε Γηαρεηξηζηήο Αξρείσλ 

2. 

 
Εικόνα 90  Επιλογή του κουμπιοφ Διαχειριςτήσ Αρχείων 2 για ανζβαςμα τον αρχείων 

 

    Μαο θαζνδεγεί πσο ζα θάλνπκε Upload επηιεγκέλα αξρεία καο ζην ρώξν 

καο ηνπ Web Server. 
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2. Ο δεύηεξνο ηξόπνο είλαη λα ρξεζηκνπνηήζνπκε έλα  πξόγξακκα FTP Client, 

έηζη ώζηε λα δεκηνπξγεζεί κία ζύλδεζε FTP Client θαη FTP Server, γηα λα 

κπνξέζεη ν Client λα ζηείιεη ηα επηζπκεηά ηνπ αξρεία ζηνλ Web Server. Έλα 

δεκνθηιέο πξόγξακκα γηα FTP Client είλαη ην filezilla, ην νπνίν κπνξνύκε λα 

ην θαηεβάζνπκε δσξεάλ από ηελ ηζηνζειίδα filezilla (15). Μεηά ηελ 

εγθαηάζηαζε ηνπ πξνγξάκκαηνο ζηνλ ππνινγηζηή καο, ην εγθαζηζηάκε όπνπ 

εκείο επηζπκνύκε, εθηεινύκε ην εθηειέζηκν αξρείν. Θα καο εκθαληζηεί ε 

εηθόλα 91. 

 

Εικόνα 91  Filezilla 

    Δπηιέγνπκε Δπεμεξγαζία θαη κεηαβαίλνπκε ζηελ επηινγή Ρπζκίζεηο εηθόλα 92. 

 

Εικόνα 92  Ρυθμίςεισ 
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    Δκθαλίδεηαη ην παξάζπξν ηεο εηθόλαο 93 ζηελ νπνία επηιέγνπκε ΢ύλδεζε. 

 
Εικόνα 93  ΢φνδεςη 

 

     Δπηιέγνπκε FTP θαη ζηελ θαηάζηαζε κεηαθνξάο ζα πξέπεη λα έρνπκε 

ηζεθαξηζκέλε  ηελ επηινγή “Δλεξγεηηθή” όπσο βιέπνπκε ζηελ εηθόλα 94. 

 
Εικόνα 94  FTP 

 

    Αθνύ παηήζνπκε ΟΚ καο εκθαλίδεηε ε εηθόλα 95. 
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Εικόνα 95  Ειςαγωγή των απαραίτητων πεδίων για την επίτευξη τησ FTP ςφνδεςησ 

 

    ΢πκπιεξώλνπκε ηα πεδία ζύκθσλα κε ηα ζηνηρεία πνπ ιάβακε κέζσ email. ΢ην 

πεδίν Κόκβνο ην Domain Name (πξνζνρή κε ftp ζηελ αξρή, ζηελ πεξίπησζή καο 

ftp.sbaliouskas.gr). ΢ην πεδίν Όλνκα ρξήζηε ην Username. ΢ην πεδίν Κσδηθόο 

πξόζβαζεο ην Password. Σν πεδίν Θύξα ην αθήζακε θελό (γηαηί από default είλαη 

21). Σέινο θάλνπκε click ζην θνπκπί  Γξήγνξε ζύλδεζε. 

    Αθνύ ε ζύλδεζε είλαη επηηπρήο ζηελ δεμηά πιεπξά ζα δνύκε ην παξάζπξν ηνπ 

ρώξνπ καο ζηνλ Web Server θαη ζην αξηζηεξό παξάζπξν ην παξάζπξν ρώξνπ ηνπ 

ππνινγηζηή καο. Μεηαθέξνπκε ηα επηιεγκέλα αξρεία από ην παξάζπξν ρώξνπ ηνπ 

ππνινγηζηή καο ζην παξάζπξν ρώξνπ ηνπ Web Server (ή θαη αληίζηξνθα) κε drag 

end drop ή κε Copy > Paste. 
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΢πκπεξάζκαηα. 

Η αλάπηπμε ηζηνζειίδσλ κε ηε ρξήζε CMS, ζηελ πεξίπησζή καο ην CMS Joomla, 

καο βνεζά λα δεκηνπξγήζνπκε ηζηνζειίδεο πςεινύ επηπέδνπ. Σν Joomla παξέρεη 

πνιιέο εθαξκνγέο αξθεηέο από ηηο νπνίεο πξνζαξκόζακε γηα λα δεκηνπξγήζνπκε ηελ 

παξνύζα ηζηνζειίδα, αιιά θαη άιιεο πνπ ζα κπνξνύζακε λα ρξεζηκνπνηήζνπκε γηα 

λα έρνπκε ην επηζπκεηό απνηέιεζκα. Τπάξρνπλ απεξηόξηζηα έηνηκα Templates, 

Modules, Components θαη Plugins πνπ κπνξνύκε λα αγνξάζνπκε ή λα βξνύκε 

δσξεάλ ζην δηαδίθηπν. Αξθεηά ζπρλά δεκνζηεύνληαη λέεο εθδόζεηο γηα ην Joomla  

πνπ δηνξζώλνπλ ηπρόλ  πξνβιήκαηα ησλ πξνεγνύκελσλ εθδόζεσλ.  

΢ηόρνο καο ήηαλ λα δεκηνπξγήζνπκε κηα ηζηνζειίδα Ξελνδνρείνπ πνπ λα 

αλαδεηθλύεη ηα πιενλεθηήκαηα ηνπ, ηηο παξερόκελεο ππεξεζίεο θαη ηηο ςπραγσγηθέο 

θαη πνιηηηζηηθέο δξαζηεξηόηεηεο πνπ ζα απνιαύζεη ν πειάηεο καο επηιέγνληαο λα 

πεξάζεη ηηο δηαθνπέο ηνπ ζην μελνδνρείν καο. 

Φπζηθά θαη ζα κπνξνύζακε ζηα πιαίζηα κηαο επαγγεικαηηθήο ηζηνζειίδαο  λα ηελ 

εκπινπηίζνπκε αθόκα πεξηζζόηεξν σο πξνο ηελ εκθάληζε θαη ηελ εηζαγσγή 

πεξηζζνηέξσλ   Modules, Components θαη Plugins. 

Σέινο ζα ήηαλ παξάιεςε καο λα κελ αλαθέξνπκε όηη ην πιηθό θσηνγξαθίεο θαη 

άξζξα, κε ζρεηηθέο δηθέο καο ηξνπνπνηήζεηο, ηα πήξακε από ηηο ηζηνζειίδεο 

δηαθόξσλ μελνδνρείσλ θαη θπξίσο από ionianvista (8) ηεο Κεθαινληάο θαη 

hotelxanthippion (16) ηεο Ξάλζεο. 

 

 

 

 

 

 

 

 

 

 

 



Σταύροσ Μπαλιούςκασ Σελίδα 91 
 

Βηβιηνγξαθία 

1. https://www.joomla.org.  

2. http://www.joomla.gr.  

3. https://www.uab.edu/brand/web/joomla/.  

4. https://www.youtube.com/watch?v=r0ur1CST8L4. 

5. http://www.sch.gr/2462-plugins-components-modules-joomla.   

6. https://www.joomshaper.com/helix.  

7. https://www.joomlacontenteditor.net.  

8.http://www.ionianvista.com/. 

9. http://www.simpleimageresizer.com/. 

10. http://jextensions.com/orbit-jquery-slideshow-for-joomla-2.5/.  

11. http://www.solidres.com.  

12. http://bowthemes.com/showcase/joomla-extensions.html. 

13. https://www.akeebabackup.com/products/akeeba-backup.html. 

14. https://www.akeebabackup.com/download/akeeba-kickstart/5-2-1.html. 

15. https://filezilla-project.org/  

16. http://www.hotelxanthippion.gr/ 
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